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Notices

Federal Communications Commission Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions:

+ This device may not cause harmful interference, and

+ This device must accept any interference received including interference that
may cause undesired operation.

This equipment has been tested and found to comply with the limits for a

Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with manufacturer’s
instructions, may cause harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a particular installation. If
this equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following
measures:

» Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

+  Connect the equipment to an outlet on a circuit different from that to which the
receiver is connected.

«  Consult the dealer or an experienced radio/TV technician for help.

f The use of shielded cables for connection of the monitor to the graphics card is
required to assure compliance with FCC regulations. Changes or modifications
to this unit not expressly approved by the party responsible for compliance
could void the user’s authority to operate this equipment.

Canadian Department of Communications Statement

This digital apparatus does not exceed the Class B limits for radio noise emissions
from digital apparatus set out in the Radio Interference Regulations of the
Canadian Department of Communications.

This class B digital apparatus complies with Canadian ICES-003.
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Safety information

Electrical safety

To prevent electrical shock hazard, disconnect the power cable from the
electrical outlet before relocating the system.

When adding or removing devices to or from the system, ensure that the power
cables for the devices are unplugged before the signal cables are connected. If
possible, disconnect all power cables from the existing system before you add
a device.

Before connecting or removing signal cables from the motherboard, ensure
that all power cables are unplugged.

Seek professional assistance before using an adpater or extension cord.
These devices could interrupt the grounding circuit.

Make sure that your power supply is set to the correct voltage in your area. If
you are not sure about the voltage of the electrical outlet you are using, contact
your local power company.

If the power supply is broken, do not try to fix it by yourself. Contact a qualified
service technician or your retailer.

Operation safety

Before installing the motherboard and adding devices on it, carefully read all
the manuals that came with the package.

Before using the product, make sure all cables are correctly connected and the
power cables are not damaged. If you detect any damage, contact your dealer
immediately.

To avoid short circuits, keep paper clips, screws, and staples away from
connectors, slots, sockets and circuitry.

Avoid dust, humidity, and temperature extremes. Do not place the product in
any area where it may become wet.

Place the product on a stable surface.

If you encounter technical problems with the product, contact a qualified
service technician or your retailer.

E This symbol of the crossed out wheeled bin indicates that the product (electrical

and electronic equipment) should not be placed in municipal waste. Check local

— regulations for disposal of electronic products.

Viii
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About this guide

This user guide contains the information you need when installing and configuring
the motherboard.

How this guide is organized

This guide contains the following parts:

Chapter 1: Product introduction

This chapter describes the features of the motherboard and the new
technology it supports.

Chapter 2: Hardware information

This chapter lists the hardware setup procedures that you have to perform
when installing system components. It includes description of the switches,
jumpers, and connectors on the motherboard.

Chapter 3: Powering up

This chapter describes the power up sequence and ways of shutting down
the system.

Chapter 4: BIOS setup

This chapter tells how to change system settings through the BIOS Setup
menus. Detailed descriptions of the BIOS parameters are also provided.
Chapter 5: Software support

This chapter describes the contents of the support CD that comes with the
motherboard package.

Chapter 6: NVIDIA® SLI™ technology support

This chapter tells how to install SLI-ready PCI Express graphics cards.

Where to find more information

Refer to the following sources for additional information and for product and
software updates.

1.

ASUS websites

The ASUS website provides updated information on ASUS hardware and
software products. Refer to the ASUS contact information.

Optional documentation

Your product package may include optional documentation, such as warranty
flyers, that may have been added by your dealer. These documents are not
part of the standard package.
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Conventions used in this guide

To make sure that you perform certain tasks properly, take note of the following
symbols used throughout this manual.

’ DANGER/WARNING: Information to prevent injury to yourself
é when trying to complete a task.

’ CAUTION: Information to prevent damage to the components
. when trying to complete a task.

R IMPORTANT: Instructions that you MUST follow to complete a

task.

%f NOTE: Tips and additional information to help you complete a

task.

Typography
Bold text
Italics

<Key>

<Key1+Key2+Key3>

Command

Indicates a menu or an item to select.

Used to emphasize a word or a phrase.

Keys enclosed in the less-than and greater-than sign
means that you must press the enclosed key.

Example: <Enter> means that you must press the
Enter or Return key.

If you must press two or more keys simultaneously, the
key names are linked with a plus sign (+).

Example: <Ctrl+Alt+D>

Means that you must type the command exactly

as shown, then supply the required item or value
enclosed in brackets.

Example: At the DOS prompt, type the command line:

awdflash M2NPLUSV.bin

Download from Www.Somanuals.com. All Manuals Search And Download.



M2N-Plus SLI Vista Edition
specifications summary

Socket AM2 for AMD Athlon™ 64 FX / AMD Athlon™ 64 X2
/ AMD Athlon 64™/ AMD Sempron™ processors

Supports AMD Cool ‘n’ Quiet™ Technology

AMD64 architecture enables simultaneous 32-bit and
64-bit computing

AMD Live!™ ready

NVIDIA® nForce® 500 SLI™ MCP
System bus 2000/ 1600 MT/s

Memory Dual-channel memory architecture

- 4 x 240-pin DIMM sockets support unbufferred
ECC/non-ECC DDR2 800/667/533 MHz memory
modules

- Supports up to 8 GB system memory

Expansion slots 2 x PCI Express™ x16 slots with NVIDIA® SLI™ support
at x8, x8 speed

2 x PCI Express™ x1 slots

2x PCl 2.2 slots

Scalable Link Interface Supports two identical NVIDIA® SLI"-ready graphics

(SLI™) cards, both at x8 mode
ASUS two-slot thermal design
Storage NVIDIA® nForce® 500 SLI™ MCP supports:
- 2 x IDE connectors for four Ultra DMA133/100/66/33
devices

- 4 x Serial ATA 3.0 Gb/s connectors support four
Serial ATA devices

- RAID 0, RAID 1, RAID 0+1, RAID 5, and JBOD
configurations spanning across Serial ATA drives

NVIDIA® nForce® 500 SLI™ MCP built-in Gigabit MAC
with external Attansic PHY
- Supports TCP/IP Acceleration

C-Media Superior Quality Audio 7.1 channel CODEC
(Vista-ready)
- Supports S/PDIF Out interface

IEEE 1394a VIA 1394 controller supports 2 x 1394a ports

Supports up to 8 USB 2.0/1.1 ports (four at mid-board,
four on the rear panel)

(continued on the next page)
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M2N-Plus SLI Vista Edition
specifications summary

ASUS Al Lifestyle ASUS Al Lifestyle Vista Edition features:

features - Al Remote
- ASAP (ASUS Accelerated Propeller)
- TPM Support (the module is purchased separately)
- AP Trigger

*ASUS Al Remote, AP Trigger, and TPM run with both
Windows® Vista and XP

ASUS Quiet Thermal Solution:
- ASUS Al Gear
- ASUS Al Nap

Overclocking features Al Overclocking (intelligent CPU frequency tuner)

Stepless Frequency Selection (SFS) allows FSB tuning
from 200 MHz up to 400 MHz at 1 MHz increment

ASUS C.P.R. (CPU Parameter Recall)

Adjustable FSB/DDR2 ratio. Fixed PCI/PCle frequencies

Special features ASUS EZ DIY:
- ASUS Q-Connector
- ASUS CrashFree BIOS 3
- ASUS EZFlash 2

ASUS Q-Fan 2

ASUS MyLogo2

Rear panel I/0 ports 1 x PS/2 keyboard port (purple)
1 x PS/2 mouse port (green)

1 x LAN (RJ-45) port

1 x IEEE 1394a port

4 x USB 2.0/1.1 ports

1 x S/PDIF Qut port

1 x Parallel port (printer port)

1 x COM port

8-channel audio ports

Internal connectors 2 x USB 2.0 connectors support four additional USB 2.0
ports

1 x Floppy disk drive connector

2 x IDE connector for four devices

4 x Serial ATA connectors

1 x CPU /1 x Chassis / 1 x Power fan connectors

1 x IEEE 1394a connector

1 x S/PDIF Out connector

Front panel audio connector

CD audio in

24-pin ATX power connector

4-pin ATX 12 V power connector

System panel connector

(continued on the next page)

Xii
Download from Www.Somanuals.com. All Manuals Search And Download.



M2N-Plus SLI Vista Edition
specifications summary

BIOS features 4 Mb BIOS ROM, AWARD BIOS, PnP, DMI 2.0, WiM2.0,
SMBIOS 2.3

Manageability WOL by PME, WOR by PME, Chassis intrusion, PXE

Accessories 1 x SLI bridge

1 x UltraDMA 133/100/66 cable

2 x SATA cables

1 x SATA power cable for 2 devices

1 x 1/0 shield

1 x ASUS Q-Connector kit (USB, system panel; Retail
version only)

Al Remote (Retail version only)

User’s manual

Support CD Drivers

ASUS PC Probe Il

ASUS Update

NVIDIA® MediaShield™ RAID
Anti-virus software (OEM version)

Form factor ATX form factor: 12 in x 8.6 in (30.5 cm x 21.8 cm)

*Specifications are subject to change without notice.

Xiii
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This chapter describes the motherboard
features and the new technologies
it supports.

Product
introduction
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1.1 Welcome!..... 11
1.2 Package contents...........cccoenieinnnnnns 1-1
1.3 Special features........ocoinrinnsnss s 1-2
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1.1 Welcomel!
Thank you for buying an ASUS® M2N-Plus SLI Vista Edition motherboard!

The motherboard delivers a host of new features and the latest technologies,
making it another standout in the long line of ASUS quality motherboards!

Before you start installing the motherboard, and hardware devices on it, check the
items in your package with the list below.

1.2 Package contents

Check your motherboard package for the following items.

Motherboard ASUS M2N-Plus SLI Vista Edition

Cables 2 x Serial ATA cables
1 x Serial ATA power cables for two devices
1 x Ultra DMA 133/100/66 cable
1 x Floppy disk drive cable

Accessories I/0 shield
ASUS SLI™ Bridge
1 x ASUS Q-Connector Kit (USB, System panel;
Retail version only)
Al Remote (Retail version only)

Application CD ASUS motherboard support CD
Documentation User guide
% If any of the above items is damaged or missing, contact your retailer.

ASUS M2N-Plus SLI Vista Edition
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1.3 Special features
1.3.1 Product highlights

Latest processor technology @ &

The motherboard comes with a 940-pin AM2 socket that supports AMD Athlon™
64 X2/Athlon™ 64/Athlon™ 64 FX/Sempron™ processor. With an integrated low-
latency high-bandwidth memory controller and a highly scalable HyperTransport™
technology-based system bus, the motherboard provides a powerful platform for
your diverse computing needs, increased office productivity, and enhanced digital
media experience. See page 2-6 for details.

NVIDIA® Scalable Link Interface (SLI™) SLI

The NVIDIA® Scalable Link Interface (SLI™) technology allows two graphics
processing units (GPUs) in a single system. This technology takes advantage of
the PCI Express™ bus architecture and features intelligent hardware and software
solutions that allows multiple GPUs to work together and achieve exceptional
graphics performance.

NVIDIA nForce® 500 SLI™

NVIDIA nForce® 500 SLI™ media and communication processors (MCPs) deliver
a complete range of solutions for AMD-based discrete platforms. Performance
enhancing features include NVIDIA® LinkBoost™ technology to automatically
increase the bus speed and NVIDIA® SLI™ technology for scalable graphics
performance.

AMD Cool ‘n’ Quiet!™ Technology m

The motherboard supports the AMD Cool ‘n’ Quiet!™ Technology that dynamically
and automatically changes the CPU speed, voltage and amount of power
depending on the task the CPU performs. See page 4-24.

iDf0fR]
DDR2 memory support .5
The motherboard supports DDR2 memory that features data transfer rates of
800/667/533 MHz to meet the higher bandwidth requirements of the latest
3D graphics, multimedia, and Internet applications. The dual-channel DDR2
architecture doubles the bandwidth of your system memory to boost system
performance, eliminating bottlenecks with peak bandwidths of up to 12.8 GB/s.
See page 2-11 and 2-12 for details.

Serial ATA 3Gb/s RAID RAIr

The motherboard supports the next-generation Serial ATA hard drives based on the
SATA 3Gb/s storage specification. The onboard NVIDIA nForce® 500 SLI™ MCP
allows RAID 0, RAID 1, RAID 0+1, RAID 5, and JBOD. See page 2-25.

Chapter 1: Product introduction
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PCI Express™ interface = b

The motherboard fully supports PCI Express, the latest /O interconnect technology
that speeds up the PCI bus. PCI Express features point-to-point serial
interconnections between devices and allows higher clockspeeds by carrying data
in packets. This high speed interface is software compatible with existing PCI
specifications. See page 2-18 and 2-19 for details.

T3,
Gigabit LAN w&0tm*
The motherboard comes with a Gigabit LAN controller built into the NVIDIA®
nForce™ 500 SLI™ chipset to meet your growing networking needs. The controller
uses the PCI Express segment to provide faster data bandwidth for your Internet,
LAN, and file sharing requirements. See page 2-22 for details.

IEEE 1394a support

The IEEE 1394a interface provides high-speed and flexible PC connectivity to
a wide range of peripherals and devices compliant to the IEEE 1394a standard.
The IEEE 1394a interface allows up to 400 Mbps transfer rates through simple,
low-cost, high-bandwidth asynchronous (real-time) data interfacing between
computers, peripherals, and consumer electronic devices such as camcorders,
VCREs, printers, TVs, and digital cameras. See page 2-22 and 2-27 for details.

USB 2.0 technology ﬁgaf.“

The motherboard implements the Universal Serial Bus (USB) 2.0 specification,
dramatically increasing the connection speed from the 12 Mbps bandwidth on USB
1.1 to a fast 480 Mbps on USB 2.0. USB 2.0 is backward compatible with USB 1.1.
See page 2-23 and 2-27 for details.

C-Media Superior Quality Audio u

C-Media CM6501 onboard 8-channel superior audio CODEC transfers audio signal
over USB bus and is Microsoft Vista-ready. See page 5-13 to 5-15 for details.

3
S/PDIF digital sound ready 4S/FDIF

The motherboard supports the S/PDIF technology through the S/PDIF interfaces
on the rear panel. The S/PDIF technology turns your computer into a high-end
entertainment system with digital connectivity to powerful audio and speaker
systems. See page 2-23 and 2-30 for details.

% This function can only work under C-Media official driver.

ASUS M2N-Plus SLI Vista Edition 1-3
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1-4

[\
1.3.2  ASUS Al Lifestyle features /A m‘!

| |
Al Remote |

The revolutionary Al Remote gives you unprecedented control from the comfort of
your couch. With just a touch of the button, you can quickly do your usual computer
activities such as turn ON/OFF your PC, launch your favorite applications by
enabling AP Trigger function, or control Al Gear and Al Nap. The Al Remote also
gives you the comfort of a traditional remote on media player. Have an Al Remote
in your hand and do more with your PC from a distance! See page 5-24 for details.

=N
ASAP (ASUS Accelerated Propeller) La

ASAP gets you to your destination ASAP. ASAP supports the Windows®
ReadyBoost™ technology which improves system performance under Windows®
Vista. Enjoy greater efficiency and get more productivity out of your system. See
page 5-32 for details.

i
AP Trigger &

The AP Trigger allows you to quickly boot or resume directly into media or into
your favorite applications. With just a touch of the button on the Al Remote
controller, you can quickly turn on your PC and launch predefined applications
simultaneously!

TPM Support [}

This motherboard supports the Trusted Platform Module (TPM), which provides
you with enhanced data protection via high-level encryption/decryption and
ensures platform integrity. The TPM meets the Windows® Vista BitLocker™ Drive
Encryption hardware requirement for a more secure working environment. See
page 2-30 and 4-38 for details.

/ The TPM module is purchased separately. Use the ASUS TPM module ONLY.

Al Gear

Al Gear allows users to choose from four modes to adjust CPU and Vcore voltage,
minimizing noise and power consumption. Users can choose the mode that best
suits their needs. See page 5-22 for details.

Al Nap

With Al Nap, the system can continue running at minimum power and noise
when the user is temporarily away. To wake the system and return to the OS
environment, simply click the mouse or press a key. See page 5-23 for details.

Chapter 1: Product introduction
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1.3.3 ASUS Special features

_—
Fanless Design [~ .

Cooling fans, though a popular thermal solution, also come with noise and
malfunction likelihood. ASUS motherboard’s fanless concept is specifically created
to provide a cool environment without all the baggage. ASUS has devoted special
efforts to address the thermal issues across the motherboard, and most notably
the areas that reside the CPU, power, Northbridge and Southbridge. The heatsinks
and strategic board layout are tailor made to dissipate heat in the most efficient

manner.

ASUS Q-Fan 2 technology §

The ASUS Q-Fan technology smartly adjusts the CPU and chassis fan speeds
according to the system loading to ensure quiet, cool, and efficient operation. See
page 4-32 and 4-33 for details.

ASUS MyLogo2™ /Mty
This new feature present in the motherboard allows you to personalize and add

style to your system with customizable boot logos. See page 5-9 and 5-10 for
details.

ASUS CrashFree BIOS 3

The ASUS CrashFree BIOS 3 allows users to restore corrupted BIOS data from a
USB flash disk containing the BIOS file. This utility saves users the cost and hassle
of buying a replacement BIOS chip. See page 4-9 for details.

ASUS EZ Flash 2 D

EZ Flash 2 is a user-friendly BIOS update utility. Simply press the predefined
hotkey to launch the utility and update the BIOS without entering the OS. Update
your BIOS easily without preparing a bootable diskette or using an OS-based flash
utility. See page 4-5 for details.

ASUS Q-Connector ::3

The ASUS Q-Connector allows you to connect or disconnect chassis front panel
cables in one easy step with one complete module. This unique adapter eliminates
the trouble of plugging in one cable at a time, making connection quick and
accurate. See page 2-33 for details.

ASUS M2N-Plus SLI Vista Edition
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1-6

',* "
Green ASUS &5
This motherboard and its packaging comply with the European Union’s Restriction
on the use of Hazardous Substances (RoHS). This is in line with the ASUS vision
of creating environment-friendly and recyclable products/packaging to safeguard
consumers’ health while minimizing the impact on the environment.

1.3.4  ASUS features and the supporting OS

Refer to the following table for the OS that supports ASUS features.

Vista 32bit | Vista 64bit

Win 2000 XP 32bit XP 64bit

Al Remote v

AP Trigger v v v v
Function as USB Flash only v v

Al Gear v v v v v
v v v v v

PC Probe Il v v v v v

Chapter 1: Product introduction
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This chapter lists the hardware setup
procedures that you have to perform
when installing system components. It
includes description of the jumpers and
connectors on the motherboard.

Hardware
information
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2.1 Before you proceed
Take note of the following precautions before you install motherboard components
or change any motherboard settings.

' + Unplug the power cord from the wall socket before touching any
° component.

Use a grounded wrist strap or touch a safely grounded object or to a metal
object, such as the power supply case, before handling components to
avoid damaging them due to static electricity.

+ Hold components by the edges to avoid touching the ICs on them.

Whenever you uninstall any component, place it on a grounded antistatic
pad or in the bag that came with the component.

Before you install or remove any component, ensure that the ATX power
supply is switched off or the power cord is detached from the power
supply. Failure to do so may cause severe damage to the motherboard,
peripherals, and/or components.

Onboard LED

The motherboard comes with a standby power LED. The green LED lights up
to indicate that the system is ON, in sleep mode, or in soft-off mode. This is a
reminder that you should shut down the system and unplug the power cable
before removing or plugging in any motherboard component. The illustration
below shows the location of the onboard LED.

= O =

L= SB_PWR

) o

D — D [

(] :}O' _ 5 > Q ‘
m%]-g@.z ON OFF

M2N-PLUS SLI Onboard LED Fogie
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2.2 Motherboard overview

Before you install the motherboard, study the configuration of your chassis to
ensure that the motherboard fits into it.

E Make sure to unplug the power cord before installing or removing the
motherboard. Failure to do so can cause you physical injury and damage
motherboard components.

2.2.1 Placement direction

When installing the motherboard, make sure that you place it into the chassis in
the correct orientation. The edge with external ports goes to the rear part of the
chassis as indicated in the image below.

2.2.2 Screw holes

Place six (6) screws into the holes indicated by circles to secure the motherboard
to the chassis.

' Do not overtighten the screws! Doing so can damage the motherboard.

Place this side towards

the rear of the chassis M2N-PLUS SLI

Chapter 2: Hardware information
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2.2.3 Motherboard layout

24.5¢cm (9.6in)
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/ Refer to 2.7 Connectors for more information about rear panel connectors and
- internal connectors.
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224 Layout contents

Slots Page

1. DDR2 DIMM slots 2-11
2. PCl slots 2-18
3. PCI Express x 1 slot 2-18
4 PCI Express x16 slots 2-19

Jumper Page

1. Clear RTC RAM (3-pin CLRTC) 2-20

2. USB device wake-up (3-pin USBPW12, USBPW34, USBPW56, 2-21
USBPW?78)

3. Keyboard power (3-pin KBPWR) 2-21

Rear panel connectors Page

1. PS/2 mouse port (green) 2-22
2. Parallel port 2-22
3. IEEE 1394a port 2-22
4. LAN (RJ-45) port. 2-22
5. Rear Speaker Out port (black) 2-22
6. Side Speaker Out port (gray) 2-22
7. Line In port (light blue) 2-22
8. Line Out port (lime) 2-22
9. Microphone port (pink) 2-23
10. Center/Subwoofer port (orange) 2-23
1. USB 2.0 ports 1 and 2, 3 and 4 2-23
12 Serial port (COM port) 2-23
13. Coaxial S/PDIF Out port 2-23
14 PS/2 keyboard port (purple) 2-23

Chapter 2: Hardware information
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Internal connectors Page

1. Floppy disk drive connector (34-1 pin FLOPPY) 2-24
2. IDE connector (40-1 pin PRI_IDE, SEC_IDE) 2-24
3. NVIDIA® nForce® 500 SLI Southbridge Serial ATA connectors 2-25

(7-pin SATA1 [red], SATA2 [red], SATAS [red], SATA4 [red])
4. CPU, chassis, and power fan connectors 2-26

(4-pin CPU_FAN, 3-pin PWR_FAN, 3-pin CHA_FAN )
5 USB connectors (10-1 pin USB56, USB78, ASAP) 2-27
6. IEEE 1394a port connector (10-1 pin IE1394_2) 2-27
7. Chassis intrusion connector (4-1 pin CHASSIS) 2-28
8 ATX power connectors (24-pin EATXPWR, 4-pin ATX12V) 2-28
9 Front panel audio connector (10-1 pin FP_AUDIO) 2-29
10. Internal audio connector (4-pin CD) 2-29
1. Digital audio connector (4-1 pin SPDIF_OUT) 2-30
12. TPM connector (20-1 pin TPM) 2-30
13. System panel connector (20-8-pin PANEL) 2-31

. System power LED (2-pin PLED)

. Hard disk drive activity LED (2-pin IDE_LED)

. System warning speaker (4-pin SPEAKER)

. ATX power button/soft-off button (2-pin PWRSW)

. Reset button (2-pin RESET)

ASUS M2N-Plus SLI Vista Edition
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2.3 Central Processing Unit (CPU)

The motherboard comes with a 940-pin AM2 socket designed for the Athlon™ 64
X2/Athlon™ 64/Athlon™ 64FX/Sempron™ processor.

) ' The AM2 socket has a different pinout from the 940-pin socket designed for
e the AMD Opteron processor. Make sure you use a CPU designed for the AM2
socket. The CPU fits in only one correct orientation. DO NOT force the CPU into
the socket to prevent bending the connectors on the socket and damaging the
CPU!

2.31 Installing the CPU
To install a CPU:

1. Locate the CPU socket on the motherboard.

Cawy

M2N-PLUS SLI CPU Socket AM2

2. Unlock the socket by pressing the
lever sideways, then lift it up to a
90° angle.

Socket lever

R Make sure that the socket lever is lifted up to a 90° angle; otherwise, the CPU
will not fit in completely.

Chapter 2: Hardware information
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3. Position the CPU above the socket
such that the CPU corner with the
gold triangle matches the socket
corner with a small triangle.

4.  Carefully insert the CPU into the
socket until it fits in place.

Gold triangle

Small triangle

5. When the CPU is in place, push
down the socket lever to secure the
CPU. The lever clicks on the side tab
to indicate that it is locked.

6. Install a CPU heatsink and fan
following the instructions that came
with the heatsink package.

ASUS M2N-Plus SLI Vista Edition
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23.2 Installing the heatsink and fan

The AMD Athlon™ 64FX/Athlon™ 64/Athlon™ 64 X2/Sempron™ processor requires a
specially designed heatsink and fan assembly to ensure optimum thermal condition
and performance.

R Make sure that you use only AMD-certified heatsink and fan assembly.

To install the CPU heatsink and fan:

1. Place the heatsink on top of the installed CPU, making sure that the heatsink
fits properly on the retention module base.

/ »  The retention module base is already installed on the motherboard upon
- purchase.

You do not have to remove the retention module base when installing the
CPU or installing other motherboard components.

+  If you purchased a separate CPU heatsink and fan assembly, make sure
that a Thermal Interface Material is properly applied to the CPU heatsink or
CPU before you install the heatsink and fan assembly.

CPU fan

CPU heatsink

Retention module base

Retention bracket

Retention bracket lock

% Your boxed CPU heatsink and fan assembly should come with installation

- instructions for the CPU, heatsink, and the retention mechanism. If the
instructions in this section do not match the CPU documentation, follow the
latter.

2-8 Chapter 2: Hardware information
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2.  Attach one end of the retention bracket
to the retention module base.

3. Align the other end of the retention
bracket (near the retention bracket
lock) to the retention module base.
A clicking sound denotes that the
retention bracket is in place.

R Make sure that the fan and

heatsink assembly perfectly fits
the retention mechanism module
base, otherwise you cannot snap
the retention bracket in place.

4. Push down the retention bracket lock
on the retention mechanism to secure
the heatsink and fan to the module
base.

ASUS M2N-Plus SLI Vista Edition
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5. When the fan and heatsink assembly is in place, connect the CPU fan cable

t

o the connector on the motherboard labeled CPU_FAN.
> CPU_FAN

CPU FAN PWR
CPU FAN IN
CPU FAN PWM

GND

i

AN

M2N-PLUS SLI CPU fan connector

Do not forget to connect the CPU fan connector! Hardware monitoring
errors can occur if you fail to plug this connector.

+  This connector is backward compatiable with old 3-pin CPU fan.

Chapter 2: Hardware information
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2.4 System memory

241 Overview

The motherboard comes with four Double Data Rate 2 (DDR2) Dual Inline Memory
Modules (DIMM) sockets.

A DDR2 module has the same physical dimensions as a DDR DIMM but has a
240-pin footprint compared to the 184-pin DDR DIMM. DDR2 DIMMs are notched
differently to prevent installation on a DDR DIMM socket.

The figure illustrates the location of the DDR2 DIMM sockets:

M2N-PLUS SLI 240-pin DDR2 DIMM sockets

Channel Sockets

Channel A DIMM_A1 and DIMM_A2
Channel B DIMM_B1 and DIMM_B2

DIMM_A1
DIMM_B1
DIMM_A2
DIMM_B2

24.2 Memory configurations

You may install 256 MB, 512 MB, 1 GB, and 2GB unbuffered ECC/non-ECC DDR2
DIMMs into the DIMM sockets.

Recommended Memory Configurations

Sockets

- | Populated | |
Single-Channel
Populated | | |
Dual-channel (1) Populated | Populated | |
Dual-channel (2) Populated | Populated | Populated | Populated

ASUS M2N-Plus SLI Vista Edition
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When using only one memory module, start installing the DDR2 DIMMs
from slot DIMM_A1 or DIMM_B1 for better overclocking capability.
For dual-channel configuration (2), you may:
install identical DIMMs in all four sockets OR
install identical DIMM pair in DIMM_A1 and DIMM_B1 (yellow sockets)
and another identical DIMM pair in DIMM_A2 and DIMM_B2 (black
sockets)

Always use identical DDR2 DIMM pairs for dual channel mode. For
optimum compatibility, it is recommended that you obtain memory modules
from the same vendor. Visit the ASUS website (www.asus.com) for the
latest Qualified Vendors list.

Important notice on installing Windows® XP 32-bit version

If you install Windows® XP 32-bit version Operating System (OS), the limitation
of this OS version is that it may reserve a certain amount of memory space for
system devices. We recommend that you install less than 3 GB system memory
if you would like to work under Windows® XP 32-bit version OS. The excess
memory installation will not cause any usage problem, but it will not give users
the benefit of manipulating this excess memory space.

Visit the ASUS FAQ site for further S )
explanation: s
http://support.asus.com/fag/faq.
aspx?SLanguage=en-us

Under General Search, make the
selections as shown, then click Search. Click the article titled “4GB memory
installed but less memory size detected.”

You also may check the URLs below for third party comments on this issue:
http:/dIsvr01.asus.com/pub/ASUS/mb/4GB_Rev1.pdf

http://www.intel.com/support/motherboards/server/sb/cs-016594.htm

This motherboard can support 8 GB physical memory under Windows® XP
Professional x64 Edition and Windows® Vista x64 Edition operating systems.
You may install a maximum of 2 GB DIMMs on each slot.

Chapter 2: Hardware information
Download from Www.Somanuals.com. All Manuals Search And Download.



24.3 Installing a DIMM

) ' \ Unplug the power supply before adding or removing DIMMs or other
e system components. Failure to do so can cause severe damage to both the
motherboard and the components.

To install a DIMM: 0
j§ DDR2 DIMM notch
1. Unlock a DIMM socket by 0 l'
pressing the retaining clips

outward.

2. Align a DIMM on the socket
such that the notch on the DIMM &=
matches the break on the socket.

3. Firmly insert the DIMM into the
socket until the retaining clips
snap back in place and the
DIMM is properly seated.

Unlocked retaining clip

k + ADDR2 DIMM is keyed with a notch so that it fits in only one direction. Do
not force a DIMM into a socket to avoid damaging the DIMM.

The DDR2 DIMM sockets do not support DDR DIMMs. DO not install DDR
DIMMs to the DDR2 DIMM sockets.

24.4 Removing a DIMM

To remove a DIMM:

1. Simultaneously press the retaining
clips outward to unlock the DIMM.

% Support the DIMM lightly with
- your fingers when pressing the =
retaining clips. The DIMM might o

get damaged when it flips out
with extra force.

DDR2 DIMM notch

2. Remove the DIMM from the socket.

ASUS M2N-Plus SLI Vista Edition
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M2N-Plus SLI Vista Edition Motherboard
Qualified Vendors Lists (QVL)

DDR2-800 MHz capability

512MB
1024MB
1024MB
512MB
256MB
512MB
1024MB
512MB
256MB
512MB
512MB
1024MB
1024MB
512MB
1024MB
512MB
1024MB
512MB
1024MB
1024MB
1024MB
2048MB
512MB
1024MB
1024MB
512MB
512MB
512MB
1024MB
512MB
1024MB

Vendor

KINGSTON
KINGSTON
KINGSTON
Qimonda
Qimonda
Qimonda
Qimonda
SAMSUNG
SAMSUNG
SAMSUNG
Hynix
Hynix
Hynix
MICRON
MICRON
MICRON
MICRON
MICRON
MICRON
CORSAIR
ELPIDA
ELPIDA
A-DATA
A-DATA
A-DATA
Crucial
Crucial
Apacer
Apacer
Transcend

Transcend

DIMM support
Chip No.
K4T51083QC Ss KVR800D2N5/512 . . .
Heat-Sink Package DS KHX6400D2LL/1G . . .
Heat-Sink Package Ss KHX6400D2LLK2/1GN
HYB18T256800AF25F DS HYS64T64020HU-25F-A . . .
HYB18T512160BF-25F SS HYS64T32000HU-25F-B . . .
HYB18T512800BF25F SS HYS64T64000HU-25F-B
HYB18T512800BF25F DS HYS64T128020HU-25F-B . . .
EDD339XX SS M378T6553CZ3-CE7 . . .
K4T51163QC-ZCE7 SS M378T3354CZ3-CE7
ZCE7K4T51083QC Ss M378T6553CZ3-CE7 . . .
HY5PS12821BFP-S5 SS HYMP564U64BP8-S5 . . .
HY5PS12821BFP-S5 DS HYMP512U64BP8-S5
HY5PS12821CFP-S5 DS HYMP512U64CP8-S5 . . .
5JAIIZODQQ SS MT8HTF6464AY-80EA3 . . .
5JAIIZ9DQQ DS MT16HTF12864AY-80EA3
5ZD22D9GKX Ss MT8HTF6464AY-80ED4 . . .
5ZD22D9GKX DS MT16HTF12864AY-80ED4 . . .
6CD22D9GKX Ss MTBHTF6464AY-80ED4
6CD22D9GKX DS MT16HTF12864AY-80ED4 . . .
Heat-Sink Package DS CM2X1024-6400C4 . . .
E1108AB-8E-E(ECC) Ss EBE10EE8ABFA-8E-E
E1108AB-8E-E(ECC) DS EBE21EE8SABFA-8E-E . . .
N/A SS M20AD6G3H3160J1E52 . . .
AD29608A8A-25EG DS M20AD6G314170G1E53
K4T51083QC(ECC) DS M20AD6G314170G1E53 . . .
Heat-Sink Package SS BL6464AA804.8FD . . .
Heat-Sink Package Ss BL6464AA804.8FD3
Heat-Sink Package DS AHU512E800C5K1C . . .
Heat-Sink Package DS AHUO1GE800C5K1C . . .
K4T51083QC ss TS64MLQB4V8J
K4T51083QC DS TS128MLQ64V8J . . .
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DDR2-667 MHz capability

Vendor

256MB
512MB
1024MB
256MB
256MB
512MB
256MB
512MB
1024MB
1024MB
256MB
512MB
1024MB
512MB
256MB
512MB
1024MB
512MB
1024MB
512MB
1024MB
512MB
512MB
256MB
512MB
1024MB
256MB
512MB
512MB
1024MB
1024MB
1024MB
1024MB
512MB
1024MB
512MB
512MB
1024MB
512MB
1024MB
512MB
1024MB
512MB
512MB

KINGSTON
KINGSTON
KINGSTON
KINGSTON
Qimonda
Qimonda
Qimonda
Qimonda
Qimonda
Qimonda
Qimonda
Qimonda
Qimonda
SAMSUNG
SAMSUNG
SAMSUNG
SAMSUNG
Hynix
Hynix
Hynix
Hynix
Hynix
Hynix
CORSAIR
CORSAIR
CORSAIR
ELPIDA
ELPIDA
A-DATA
A-DATA
crucial
crucial
crucial
Apacer
Apacer
Kingmax
Transcend
Transcend
Transcend
Transcend
Super Talent
Super Talent
SMART
SMART

DIMM support
Chip No.
HYB18T256800AF3 SS KVR667D2N5/256 . . .
D6408TEBGGL3U SS KVR667D2N5/512 . . .
D6408TEBGGL3U Ds KVR667D2N5/1G
HYB18T256800AF3S SS KVR667D2N5/256 . . .
HYB18T512160AF-3S SS HYS64T32000HU-3S-A . . .
HYB18T512800AF3S SS HYS64T64000HU-3S-A
HYB18T256800AF3S(ECC) SS HYS72T32000HU-3S-A . . .
HYB18T512800AF3S(ECC) SS HYS72T64000HU-3S-A . . .
HYB18T512800AF3S(ECC) DS HYS72T128020HU-3S-A
HYB18T512800BF3S(ECC) DS HYS72T128020HU-3S-B . . .
HYB18T512160BF-3S SS HYS64T32000HU-3S-B . . .
HYB18T512800BF3S SS HYS64T64000HU-3S-B
HYB18T512800BF3S DS HYS64T128020HU-3S-B . . .
ZCE6K4T51083QC SS M378T6553CZ0-CE6 . . .
K4T51163QC-ZCE6 SS M378T3354CZ3-CE6
K4T51083QC SS M378T6553CZ3-CE6 . . .
ZCE6K4T51083QC DS M378T2953CZ3-CE6 . . .
HY5PS12821AFP-Y5 SS HYMP564U64AP8-Y5
HY5PS1G831FP-Y5(ECC) SS HYMP112U72P8-Y5 . . .
HY5PS12821AFP-Y5(ECC) SS HYMP564U72AP8-Y5 . . .
HY5PS12821AFP-Y5(ECC) DS HYMP512U72AP8-Y5
HY5PS12821AFP-Y4 SS HYMP564U64AP8-Y4 . . .
HY5PS12821AFP-Y4(ECC) SS HYMP564U72AP8-Y4 . . .
MI100605 SS VS256MB667D2
64MBCFEG SS V8512MB667D2 . . .
64MBCFEG DS VS1GB667D2 . . .
E2508AB-6E-E SS EBE25UCBABFA-6E-E
E5108AE-6E-E SS EBE51UDBAEFA-6E-E . . .
AD29608A8A-3EG SS M20AD5G3H316611C52 . . .
AD29608A8A-3EG DS M20AD5G31417611C52
Heat-Sink Package DS BL12864AA663.16FD . . .
Heat-Sink Package DS BL12864AL664.16FD . . .
Heat-Sink Package Ds BL12864AA663.16FD2
AM4B5708GQJS7E0628F SS AU512E667C5KBGC . . .
AM4B5708GQJS7E DS AU01GE667C5KBGC . . .
KKEA88B4LAUG-29DX SS KLCC28F-A8KB5
E5108AE-6E-E SS TS64MLQ64VEJ . . .
E5108AE-6E-E DS TS128MLQ64V6J . . .
J12Q3AB-6 SS JM367Q643A-6
J12Q3AB-6 DS JM388Q643A-6 . . .
Heat-Sink Package SS T6UA512C5 . . .
Heat-Sink Package Ds T6UB1GC5
G64M8XB3ITIX4TUE SS TB3D2667C58S . . .
G64MBXB3ITIX4TUE DS TB4D2667C58D . . .
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DDR2-533 MHz capability

SS/ DIMM support
Size Vendor Chip No. - Part No. e > &
256MB KINGSTON E5116AF-5C-E SS KVR533D2N4/256
512MB KINGSTON HYB18T512800AF37 SS KVR533D2N4/512
1024MB KINGSTON 5YDIID9GCT DS KVR533D2N4/1G
512MB Qimonda HYB18T512800BF37 SS HYS64T64000HU-3.7-B
1024MB Qimonda HYB18T512800BF37 DS HYS64T128020HU-3.7-B
256MB SAMSUNG K4T51163QC-ZCD5 SS M378T3354CZ3-CD5
512MB SAMSUNG ZCD5K4T51083QC SS M378T6553CZ3-CD5
1024MB SAMSUNG ZCD5K4T51083QC DS M378T2953CZ3-CD5
512MB Hynix HY5PS12821F-C4 SS HYMP564U648-C4
1024MB Hynix HY5PS12821F-C4(ECC) DS HYMP512U728-C4
512MB Hynix HY5PS12821FP-C4(ECC) SS HYMP564U728-C4
512MB Hynix HY5PS12821AFP-C3 SS HYMP564U64AP8-C3
1024MB Hynix HY5PS12821AFP-C3 DS HYMP512U64AP8-C3
1024MB CORSAIR 64M8CEDG DS VS1GB533D2
512MB ELPIDA E5108AB-5C-E SS EBE51UD8ABFA-5C-E
512MB KINGMAX E5108AE-5C-E SS KLBC28F-ABEB4
1024MB KINGMAX E5108AE-5C-E DS KLBD48F-ABEB4
512MB KINGMAX KKEABBE4AAK-37 SS KLBC28F-A8KE4
1024MB KINGMAX 5MB22D9DCN DS KLBD48F-A8ME4
512MB Super Talent Heat-Sink Package SS T5UA512C4
1024MB Super Talent Heat-Sink Package DS T5UB1G8C4

R +  A*: Supports one module inserted in any slot as Single-channel memory
configuration.

+  B*: Supports one pair of modules inserted into either the yellow slots or the
black slots as one pair of Dual-channel memory configuration.

+ C*: Supports 4 modules inserted into both the yellow and black slots as two
pairs of Dual-channel memory configuration.

R Visit the ASUS website for the latest DDR2-800/667/533 MHz QVL.
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2.5 Expansion slots

In the future, you may need to install expansion cards. The following sub-sections
describe the slots and the expansion cards that they support.

E Make sure to unplug the power cord before adding or removing expansion
cards. Failure to do so may cause you physical injury and damage motherboard
components.

2.5.1 Installing an expansion card

To install an expansion card:

1. Before installing the expansion card, read the documentation that came with
it and make the necessary hardware settings for the card.

2. Remove the system unit cover (if your motherboard is already installed in a
chassis).

3. Remove the bracket opposite the slot that you intend to use. Keep the screw
for later use.

4.  Align the card connector with the slot and press firmly until the card is
completely seated on the slot.

5. Secure the card to the chassis with the screw you removed earlier.
Replace the system cover.

25.2  Configuring an expansion card

After installing the expansion card, configure the it by adjusting the software
settings.

1. Turn on the system and change the necessary BIOS settings, if any. See
Chapter 4 for information on BIOS setup.

2. Assign an IRQ to the card. Refer to the tables on the next page.
3. Install the software drivers for the expansion card.

R When using PCI cards on shared slots, ensure that the drivers support “Share
IRQ” or that the cards do not need IRQ assignments; otherwise, conflicts will
arise between the two PCI groups, making the system unstable and the card
inoperable.

ASUS M2N-Plus SLI Vista Edition 2-17
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253 Interrupt assignments
Standard interrupt assignments

|3{e] Priority  Standard function

0 1 System Timer

1 2 Keyboard Controller

2 - Redirect to IRQ#9

4 12 Communications Port (COM1)*
5 13 IRQ Holder for PCI Steering*

6 14 Floppy Disk Controller

7 15 Printer Port (LPT1)*

8 3 System CMOS/Real Time Clock
9 4 IRQ Holder for PCI Steering*
10 5 IRQ Holder for PCI Steering*
11 6 IRQ Holder for PCI Steering*
12 7 PS/2 Compatible Mouse Port*
13 8 Numeric Data Processor

14 9 Primary IDE Channel

* These IRQs are usually available for ISA or PCI devices.

IRQ assignments for this motherboard

A B (o} D E F G H
PCI 1 - shared - - - - - -
PCI 2 - - shared - - - - -
Onboard 1394 shared - - - - - - -
PCIE x16_1 shared - - - - - - -
PCIE x16_2 - - - - - shared
PCIE x 1_1 - - - - - - shared -
PCIEx1_2 — — — — shared — — —

2.5.4 PCI slots

The PCI slots support cards such as a LAN card, SCSI card, USB card, and other
cards that comply with PCI specifications. Refer to the figure on the next page for
the location of the slots.

255 PCI Express x1 slots

This motherboard supports PCI Express x1 network cards, SCSI cards and other
cards that comply with the PCI Express specifications. Refer to the figure on the
next page for the location of the slots.
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2.5.6 PCI Express x16 slots

This motherboard supports two NVIDIA® SLI™-ready PCI Express x16 graphic
cards that comply with PCI Express specifications. Refer to the figure below for the
location of the slots.

J
w
m
3
r
o
z
o]
g

PCIl Express x16_1 slot (blue) PCl slot

PCI Express x1 slot PCl slot
PCI Express x1 slot  PCI Express x16_2 slot (black)

R + Connect a rear chassis fan to the chassis (CHA_FAN1) connector when
using two graphics cards for better thermal environment. See page 2-26 for
details.

Due to chipset limitation, the black PCI Express x16 (PCIEX16_2) slot can
run only up to x8 speed.

+ We recommend that you provide sufficient power when running NVIDIA®
SLI™ mode. See pages 2-28 and 2-29 for details.

See chapter 6 for details on the NVIDIA SLI™ technology feature.

PCIE x16_1 (Blue) slot PCIE x16_2 (Black) slot

PCle x16 graphics card | x16 | NA | -
Non-SLI mode PCle x16 graphics card | x8 | PCle x16 graphics card | x8
PCle x16 graphics card x8 ‘ Other PCle devices XS)’(1X4’

Dual-graphics
card in SLI mode

Two identical NVIDIA® SLI™ Edition graphics cards at x8, x8 speed

ASUS M2N-Plus SLI Vista Edition
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2.6 Jumper

1. Clear RTC RAM (3-pin CLRTC)

This jumper allows you to clear the Real Time Clock (RTC) RAM in
CMOS. You can clear the CMOS memory of date, time, and system setup
parameters by erasing the CMOS RTC RAM data. The onboard button
cell battery powers the RAM data in CMOS, which include system setup
information such as system passwords.

To erase the RTC RAM:
1. Turn OFF the computer and unplug the power cord.

2. Remove the onboard battery.

3. Move the jumper cap from pins 1-2 (default) to pins 2-3. Keep the cap on
pins 2-3 for about 5~10 seconds, then move the cap back to pins 1-2.

4. Reinstall the battery.

5. Plug the power cord and turn ON the computer.

6. Hold down the <Del> key during the boot process and enter BIOS setup
to re-enter data.

Except when clearing the RTC RAM, never remove the cap on CLRTC jumper
default position. Removing the cap will cause system boot failure!

=0 =

0O — o

= L) CLRTC
e A > 12 23
| .0

M2N-PLUS SLI Clear RTC RAM Doty CerRTe

R + Make sure to re-enter your previous BIOS settings after you clear the
CMOS.

You do not need to clear the RTC when the system hangs due to
overclocking. For system failure due to overclocking, use the C.P.R. (CPU
Parameter Recall) feature. Shut down and reboot the system so the BIOS
can automatically reset parameter settings to default values.
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USB device wake-up (3-pin USBPW12, USBPW34, USBPW56,
USBPW?78)

Set these jumpers to +5V to wake up the computer from S1 sleep mode
(CPU stopped, DRAM refreshed, system running in low power mode) using
the connected USB devices. Set to +5VSB to wake up from S3 and S4 sleep
modes (no power to CPU, DRAM in slow refresh, power supply in reduced
power mode).

USBPW12 USBPW34
3 12 23
zﬁ 2 - oo
> 1 +5V +5VSB
+5V +5VSB (Default)
(Default)
USBPW56
USBPW78
D — O] 12 23
— o o= - = 0B a- -
pe——al | I
S
M2N-PLUS SLI USB device wake-up (D;?:;{m) +oVSR
R + The USB device wake-up feature requires a power supply that can provide

3.

500mA on the +5VSB lead for each USB port; otherwise, the system would
not power up.

The total current consumed must NOT exceed the power supply capability
(+5VSB) whether under normal condition or in sleep mode.

Keyboard power (3-pin KBPWR)

This jumper allows you to enable or disable the keyboard wake-up feature.
Set this jumper to pins 2-3 (+5VSB) if you wish to wake up the computer
when you press a key on the keyboard (the default value is [Disabled)]). This
feature requires an ATX power supply that can supply at least 1A on the
+5VSB lead, and a corresponding setting in the BIOS. See section 4.5.3 APM
Configuration.

20N
=] > KBPWR
12 23
L] oG
@ +5V +5VSB
= - D [ HH (Default)
O
0|
D E D ]
[ =— Ll
:}9 ° %’-%E

Lo e | ——

M2N-PLUS SLI Keyboard power setting

ASUS M2N-Plus SLI Vista Edition
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2.7
2.7.1

Connectors

Rear panel connectors
© 7
&8
&9

LAN

Activity/Link Speed LED

OFF

| No link | OFF 10 Mbps connection = =
ORANGE | Linked | ORANGE | 100 Mbps connection

BLINKING | Data activity | GREEN 1 Gbps connection LAN port

PS/2 mouse port (green). This port is for a PS/2 mouse.

Parallel port. This 25-pin port connects a parallel printer, a scanner, or other
devices.

IEEE 1394a port. This 6-pin IEEE 1394a port provides high-speed
connectivity for audio/video devices, storage peripherals, PCs, or portable
devices.

LAN (RJ-45) port. Supported by the NVIDIA® nForce™ 500 Gigabit MAC with
external Attansic PHY, this port allows Gigabit connection to a Local Area
Network (LAN) through a network hub. Refer to the table below for the LAN
port LED indications.

port LED indications

ACT/LINK SPEED
LED LED

Rear Speaker Out port (black). This port connects the rear speakers in an
8-channel audio configuration.

Side Speaker Out port (gray). This port connects the side speakers in a
4-channel, 6-channel, or 8-channel audio configuration.

Line In port (light blue). This port connects the tape, CD, DVD player, or
other audio sources.

Line Out port (lime). This port connects a headphone or a speaker. In
4-channel, 6-channel, and 8-channel configuration, the function of this port
becomes Front Speaker Out.

Chapter 2: Hardware information
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9.  Microphone port (pink). This port connects a microphone.

10. Center/Subwoofer port (orange). This port connects the center/subwoofer
speakers.

% Refer to the audio configuration table below for the function of the audio ports in

& 2, 4, 6, or 8-channel configuration.

Audio 2, 4, 6, or 8-channel configuration

Headset

Port 4-channel 6-channel 8-channel
2-channel

Light Blue | Line In Line In Line In Line In

Lime Line Out Front Speaker Out | Front Speaker Out | Front Speaker Out
Pink Mic In Mic In Mic In Mic In

Orange - - Center/Subwoofer | Center/Subwoofer
Black - - - Rear Speaker Out
Gray — Side Speaker Out | Side Speaker Out Side Speaker Out

11. USB 2.0 ports 1 and 2, 3 and 4. These 4-pin Universal Serial Bus (USB)
ports are available for connecting USB 2.0 devices.

% Connect the IR receiver ONLY to USB port 1 and 2, which support remote
~ control function. Plugging any other USB devices to these two ports will turn on

the computer.

12. Serial port (COM port). This 9-pin COM port is for pointing devices and
other serial devices.

13. Coaxial S/PDIF Out port. This port connects an external audio output device
via a coaxial S/PDIF cable.

14. PS/2 keyboard port (purple). This port is for a PS/2 keyboard.

ASUS M2N-Plus SLI Vista Edition 2-23
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2.7.2 Internal connectors

1.  Floppy disk drive connector (34-1 pin FLOPPY)
This connector is for the provided floppy disk drive (FDD) signal cable. Insert
one end of the cable to this connector, then connect the other end to the
signal connector at the back of the floppy disk drive.

% Pin 5 on the connector is removed to prevent incorrect cable connection when
using a FDD cable with a covered Pin 5.

| FLOPPY

—
[ D o NOTE: Orient the red markings on
the floppy ribbon cable to PIN 1.

o 0 O e e PN 1
M2N-PLUS SLI Floppy disk drive connector

2. IDE connector (40-1 pin PRI_IDE, SEC_IDE)
The onboard IDE connector is for the Ultra DMA 133/100/66 signal cable.
There are three connectors on each Ultra DMA 133/100/66 signal cable:
blue, black, and gray. Connect the blue connector to the motherboard’s IDE
connector, then select one of the following modes to configure your device.

Drive jumper setting Mode of Cable connector
device(s)
Single device Cable-Select or Master | — Black
Master Black
Cable-Select
) Slave Gray
Two devices
Master | Master Black or gray
Slave | Slave

+  Pin 20 on the IDE connector is removed to match the covered hole on the
Ultra DMA cable connector. This prevents incorrect insertion when you
connect the IDE cable.

Use the 80-conductor IDE cable for Ultra DMA 100/66 IDE devices.

R If any device jumper is set as “Cable-Select,” make sure all other device
jumpers have the same setting.
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NOTE: Orient the red markings
(usually zigzag) on the IDE
ribbon cable to PIN 1.

SEC_IDE
PRI_IDE

PIN 1

M2N-PLUS SLI IDE connectors

3. NVIDIA® nForce® 500 SLI Southbridge Serial ATA connectors
(7-pin SATA1 [red], SATA2 [red], SATA3 [red], SATA4 [red])

These connectors are for the Serial ATA signal cables for Serial ATA 3.0
Gb/s hard disk and optical disk drives. The Serial ATA 3.0 Gb/s is backward
compatible with Serial ATA 1.5 Gb/s specification.

If you installed Serial ATA hard disk drives, you can create a RAID 0, RAID
1, RAID 0+1, RAID 5, or JBOD configuration through the onboard NVIDIA®
MediaShield™ controller.

% The RAID function of these connectors is set to [Disabled] by default. If you

intend to create a Serial ATA RAID set using these connectors, enable the RAID
Enable item in the SATA Configuration sub-menu in the BIOS. See section
4.4.4 Onboard Device Configuration for details.

SATA1 SATA3

RSATA_RXN1
RSATA_RXP1
RSATA_TXN1

RSATA_TXP1

RSATA_RXN3
RSATA_RXP3
RSATA_TXN3
RSATA_TXP3

GND
GND
GND
GND
GND
GND

|
L

SATA2 SATA4

RSATA TXP2

RSATA_TXP4

RSATA_TXN4
GND

=
g
<
1
<
=
4
&
-4

GND
RSATA_RXN2
RSATA_RXP2
GND
RSATA_TXN2
GND
GND
RSATA_RXN4

o
z
G

M2N-PLUS SLI SATA connectors
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4,

Connect the right-angle side

of SATA signal cable to SATA
device. Or you may connect the
right-angle side of SATA cable to
the onboard SATA port to avoid
mechanical conflict with huge
graphics cards.

right angle side

CPU, chassis, and power fan connectors

(4-pin CPU_FAN, 3-pin PWR_FAN, 3-pin CHA_FAN)

The fan connectors support cooling fans of 350 mA~2000 mA (24 W max.)
or a total of 1 A~7 A (84 W max.) at +12V. Connect the fan cables to the fan
connectors on the motherboard, making sure that the black wire of each
cable matches the ground pin of the connector.

Do not forget to connect the fan cables to the fan connectors. Insufficient air
flow inside the system may damage the motherboard components. These are
not jumpers! Do not place jumper caps on the fan connectors!

SF—> CPUFAN £ 2

H i

5555

U_. HH PWR_FAN 20
GND

i — o EEL%X‘iOn
D — D (1]

——— 0 CHA_FAN
U —y, == ano
o e Eﬁotation

M2N-PLUS SLI Fan connectors

feature.

Only the CPU_FAN and CHA_FAN connectors support the ASUS Q FAN2

+ Ifyou install two VGA cards, we recommend that you plug the rear
chassis fan cable to the motherboard connector labled CHA_FAN

for better themal environment.
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5. USB connectors (10-1 pin USB56, USB 78, ASAP)

These connectors are for USB 2.0 ports. Connect the USB module cable
to any of these connectors, then install the module to a slot opening at the
back of the system chassis. These USB connectors comply with USB 2.0
specification that supports up to 480 Mbps connection speed.

USB56 USB78

>
w»
>
o)

GND
USB_P9+
USB_P9-
USB+5V

USB+5V

M2N-PLUS SLI USB 2.0 connectors

' Never connect a 1394 cable to the USB connectors. Doing so will damage the
motherboard!

% The USB module is purchased separately.

6. IEEE 1394a port connector (10-1 pin IE1394_2)
This connector is for a [IEEE 1394a port. Connect the IEEE 1394a module
cable to this connector, then install the module to a slot opening at the back
of the system chassis.

0 || weerossu
b -

g = .
0 AN AN
S O
——
O—0c.5xp IE1394 2 [:I:E:[:]j
= > 1
e S > 4247
M2N-PLUS SLI IEEE 1394a connector 508+

% The IEEE 1394a module is purchased separately.

ASUS M2N-Plus SLI Vista Edition
Download from Www.Somanuals.com. All Manuals Search And Download.

2-27



7. Chassis intrusion connector (4-1 pin CHASSIS)

This connector is for a chassis-mounted intrusion detection sensor or switch.
Connect one end of the chassis intrusion sensor or switch cable to this
connector. The chassis intrusion sensor or switch sends a high-level signal to
this connector when a chassis component is removed or replaced. The signal
is then generated as a chassis intrusion event.

By default , the pin labeled “Chassis Signal” and “Ground” are shorted with
a jumper cap. Remove the jumper caps only when you intend to use the
chassis intrusion detection feature.

Chassis Signal

+5VSB_MB
GND

CHASSIS GT
—

(Default)
M2N-PLUS SLI Chassis intrusion connector

8.  ATX power connectors (24-pin EATXPWR, 4-pin ATX12V)

These connectors are for ATX power supply plugs. The power supply plugs
are designed to fit these connectors in only one orientation. Find the proper
orientation and push down firmly until the connectors completely fit.

> ATX12V EATXPWR
GND —&# @— GND
+12V DC—#PHF— +12V DC +3 Volts —== [z=— +3 Volts
-12 Volts === [z==— +3 Volts
Ground —== |£= Ground
= PSON# —== [z=— +5 Volts
- Ground
+5 Volts
Ground —=- [z=— Ground
-5 Volts —== [&-=— Power OK
+5 Volts === === +5V Standby

+12 Volts
+12 Volts
Ground === == +3 Volts

M2N-PLUS SLI ATX power connectors
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A& +  Forafully configured system, we recommend that you use a power supply
unit (PSU) that complies with ATX 12 V Specification 2.0 (or later version)
and provides a minimum power of 600 W.

Do not forget to connect the 4-pin ATX +12 V power plug; otherwise, the
system will not boot.

Use of a PSU with a higher power output is recommended when
configuring a system with more power-consuming devices. The system
may become unstable or may not boot up if the power is inadequate.

9.  Front panel audio connector (10-1 pin FP_AUDIO)

This connector is for a chassis-mounted front panel audio 1/0 module that
supports legacy AC ‘97 audio standard. Connect one end of the front panel
audio 1/0 module cable to this connector.

BLINE_OUT_R
BLINE_OUT_L

AGND
+5VA

>

y
-n
o
>
c
9

%

Mic2
MICPWR
NC

Line out_L

Line out_R

M2N-PLUS SLI Front panel audio connector

10. Internal audio connector (4-pin CD)

These connectors allow you to receive stereo audio input from sound
sources such as a CD-ROM, TV-tuner, or MPEG card.

CD
(black)
Right Audio Channel
| Ground
Ground
Left Audio Channel

M2N-PLUS SLI Internal audio connector
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11. Digital audio connector (4-1 pin SPDIF_OUT)

This connector is for an additional Sony/Philips Digital Interface (S/PDIF)
port(s). Connect the S/PDIF Out module cable to this connector, then install
the module to a slot opening at the back of the system chassis.

SPDIF_OUT

GND
3 SPDIFOUT
+5V

M2N-PLUS SLI Digital audio connector

% The S/PDIF module is purchased separately.

12. TPM connector (20-1 pin TPM)

This connector supports a Trusted Platform Module (TPM) system, which can
securely store keys, digital certificates, passwords, and data. A TPM system
also helps enhance network security, protects digital identities, and ensures
platform integrity. See section “4.6.6 Security” for details.

TPM (LLEEEEEET

M2N-PLUS SLI TPM connector

% The TPM module is purchased separately. Use the ASUS TPM module ONLY.
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13.

System panel connector (20-8 pin PANEL)

This connector supports several chassis-mounted functions.

PANEL

SPEAKER |-| G roon —HRESET

Ground=t-
T e PWRSW
PLED PLED_Z_- IDE_LED-
PLED+-=_o} IDE_LED+ IDE_LED
* Requires an ATX power supply.
M2N-PLUS SLI System panel connector

System power LED (2-pin PLED)

This 2-pin connector is for the system power LED. Connect the chassis
power LED cable to this connector. The system power LED lights up when
you turn on the system power, and blinks when the system is in sleep mode.

Hard disk drive activity LED (2-pin IDE_LED)

This 2-pin connector is for the HDD Activity LED. Connect the HDD Activity
LED cable to this connector. The IDE LED lights up or flashes when data is
read from or written to the HDD.

System warning speaker (4-pin SPEAKER)

This 4-pin connector is for the chassis-mounted system warning speaker. The
speaker allows you to hear system beeps and warnings.

ATX power button/soft-off button (2-pin PWRSR)

This connector is for the system power button. Pressing the power button
turns the system on or puts the system in sleep or soft-off mode depending
on the BIOS settings. Pressing the power switch for more than four seconds
while the system is ON turns the system OFF.

Reset button (2-pin RESET)

This 2-pin connector is for the chassis-mounted reset button for system
reboot without turning off the system power.

ASUS M2N-Plus SLI Vista Edition
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ASUS Q-Connector (system panel)

You can use the ASUS Q-Connector to connect/disconnect chassis front panel
cables in a few steps. Refer to the instructions below to install the ASUS Q-

Connector.

1. Connect the front panel cables to the
ASUS Q-Connector.

Refer to the labels on the Q-Connector
to know the detailed pin definitions, then
match them to the respective front panel
cable labels.

2. Install the ASUS Q-Connector to the
system panel connector, making sure
the orientation matches the labels on the
motherboard.

3. The front panel functions are now enabled. T
The figure shows the Q-Connector properly (8 St

installed on the motherboard.

2-32
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This chapter describes the power up
sequence, the vocal POST messages,
and ways of shutting down the system.

Powering up
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3.1
3.2

Starting up for the first time . 3-1
Turning off the computer.........ccccvcenicsrsissennes 3-2
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3.1 Starting up for the first time

1. After making all the connections, replace the system case cover.
2. Be sure that all switches are off.
3. Connect the power cord to the power connector at the back of the system

chassis.

4.  Connect the power cord to a power outlet that is equipped with a surge
protector.

5. Turn on the devices in the following order:
a. Monitor

b. External SCSI devices (starting with the last device on the chain)
c. System power

6.  After applying power, the system power LED on the system front panel case

lights up. For systems with ATX power supplies, the system LED lights up

when you press the ATX power button. If your monitor complies with “green”
standards or if it has a “power standby” feature, the monitor LED may light up

or switch between orange and green after the system LED turns on.

The system then runs the power-on self tests or POST. While the tests are
running, the BIOS beeps (see BIOS beep codes table below) or additional

messages appear on the screen. If you do not see anything within 30

seconds from the time you turned on the power, the system may have failed a
power-on test. Check the jumper settings and connections or call your retailer

for assistance.

7.  Atpower on, hold down the <Delete> key to enter the BIOS Setup. Follow the

instructions in Chapter 4.

ASUS M2N-Plus SLI Vista Edition
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3.2 Turning off the computer

3.2.1 Using the OS shut down function
If you are using Windows® 2000:

Click the Start button then click Shut Down.

2. Make sure that the Shut Down option button is selected, then click the OK
button to shut down the computer.

3. The power supply should turn off after Windows® shuts down.

If you are using Windows® XP:

1. Click the Start button then select Turn Off Computer.
2. Click the Turn Off button to shut down the computer.
3. The power supply should turn off after Windows® shuts down.

If you are using Windows® Vista:

1. Click the Start button then select ShutDown.
2. The power supply should turn off after Windows® shuts down.

3.2.2 Using the dual function power switch

While the system is ON, pressing the power switch for less than four seconds puts
the system to sleep mode or to soft-off mode, depending on the BIOS setting.
Pressing the power switch for more than four seconds lets the system enter the
soft-off mode regardless of the BIOS setting. Refer to section “4.5 Power Menu” in
Chapter 4 for details.

Chapter 3: Powering up
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This chapter tells how to change

the system settings through the BIOS
Setup menus. Detailed descriptions
of the BIOS parameters are also
provided.

BIOS setup
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4.1 Managing and updating your BIOS

The following utilities allow you to manage and update the motherboard Basic
Input/Output System (BIOS) setup.

1. ASUS Update (Updates the BIOS in Windows® environment.)

2. ASUS EZ Flash 2 (Updates the BIOS in DOS using a floppy disk / USB flash
disk, or the motherboard support CD.)

3. Award BIOS Flash Utility (Updates the BIOS using a bootable floppy disk /
USB flash disk or a CD ROM.)

4.  ASUS CrashFree BIOS 3 (Updates the BIOS using a bootable floppy disk
/ USB flash disk or the motherboard support CD when the BIOS file fails or
gets corrupted.)

Refer to the corresponding sections for details on these utilities.

R Save a copy of the original motherboard BIOS file to a bootable floppy disk in
case you need to restore the BIOS in the future. Copy the original motherboard
BIOS using the ASUS Update or Award BIOS Flash utilities.

4.1.1 ASUS Update utility

The ASUS Update is a utility that allows you to manage, save, and update the
motherboard BIOS in Windows® environment. The ASUS Update utility allows you
to:

Save the current BIOS file

Download the latest BIOS file from the Internet

Update the BIOS from an updated BIOS file

Update the BIOS directly from the Internet, and

View the BIOS version information.

This utility is available in the support CD that comes with the motherboard
package.

% ASUS Update requires an Internet connection either through a network or an
Internet Service Provider (ISP).

Installing ASUS Update
To install ASUS Update:

1. Place the support CD in the optical drive. The Drivers menu appears.

2. Click the Utilities tab, then click Install ASUS Update VX.XX.XX. See page
5-3 for the Ultilities screen menu.

3.  The ASUS Update utility is copied to your system.

ASUS M2N-Plus SLI Vista Edition
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% Quit all Windows® applications before you update the BIOS using this utility.

Updating the BIOS through the Internet
To update the BIOS through the Internet:

1. Launch the ASUS Update utility from the Windows® desktop by clicking Start
> Programs > ASUS > ASUSUpdate > ASUSUpdate. The ASUS Update
main window appears.
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2. Select Update BIOS from the 3. Select the ASUS FTP site nearest
Internet option from the drop-down you to avoid network traffic, or
menu, then click Next. click Auto Select. Click Next.
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4.  From the FTP site, select the BIOS
version that you wish to download.
Click Next.

5. Follow the screen instructions to
complete the update process.

the Internet. Always update the
utility to avail all its features.

% The ASUS Update utility is
capable of updating itself through

Updating the BIOS through a BIOS file

To update the BIOS through a BIOS file:

\ Select the BIOS Version
; e ol ek ot st

1. Launch the ASUS Update utility from the Windows® desktop by clicking Start
> Programs > ASUS > ASUSUpdate > ASUSUpdate. The ASUS Update

main window appears.

2. Select Update BIOS from a file
option from the drop-down menu,
then click Next.

3. Locate the BIOS file from the Open
window, then click Open.

4.  Follow the screen instructions to
complete the update process.
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4.1.2 Creating a bootable floppy disk

1.

Do either one of the following to create a bootable floppy disk.

DOS environment

a. Insert a 1.44MB floppy disk into the drive.
b. Atthe DOS prompt, type format A:/S then press <Enter>.

Windows® XP environment

a. Insert a 1.44 MB floppy disk to the floppy disk drive.

b. Click Start from the Windows® desktop, then select My Computer.
c. Select the 3 1/2 Floppy Drive icon.
d

Click File from the menu, then select Format. A Format 3 1/2 Floppy
Disk window appears.

e. Select Create an MS-DOS startup disk from the format options field,
then click Start.

Windows® 2000 environment

To create a set of boot disks for Windows® 2000:

a. Insert a formatted, high density 1.44 MB floppy disk into the drive.

b. Insert the Windows® 2000 CD to the optical drive.

c. Click Start, then select Run.

d. From the Open field, type
D:\bootdisk\makeboot a:

assuming that D: is your optical drive.

e. Press <Enter>, then follow screen instructions to continue.

Copy the original or the latest motherboard BIOS file to the bootable floppy
disk.

Chapter 4: BIOS setup
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41.3  ASUS EZ Flash 2 utility

The ASUS EZ Flash 2 feature allows you to update the BIOS without having to go
through the long process of booting from a floppy disk and using a DOS-based
utility. The EZ Flash 2 utility is built-in the BIOS chip so it is accessible by pressing
<Alt> + <F2> during the Power-On Self Tests (POST).

To update the BIOS using EZ Flash 2:
1. Visit the ASUS website (www.asus.com) to download the latest BIOS file for
the motherboard.

2. Save the BIOS file to a floppy disk or a USB flash disk, then restart the
system.

3. You can launch the EZ Flash 2 by two methods.

(1) Insert the floppy disk / USB flash disk that contains the BIOS file to the
floppy disk drive or the USB port.

Press <Alt> + <F2> during POST to display the following.

ASUSTek EZ Flash 2 BIOS ROM Utility B318
FLASH TYPE: PMC Pm49FL004T LPC/FWH
Current ROM

Update ROM
BOARD: M2N-Plus SLI BOARD: Unknown
VER: 0107 VER: Unknown
DATE: 12/27/2006 DATE: Unknown

Note
[Enter] Select [S] save [ESC] Exit
[Tab] Switch [Up/Down/Home/End] Move

(2) Enter BIOS setup program. Go to the Tools menu to select EZ Flash2
and press <Enter> to enable it.

You can switch between drives by pressing <Tab> before the correct file
is found. Then press <Enter>.

4. When the correct BIOS file is found, EZ Flash 2 performs the BIOS update
process and automatically reboots the system when done.

y '\ +  This function can support devices such as USB flash disk, hard disk, or
Lo floppy disk with FAT 32/16/12 format only.

+ Do not shut down or reset the system while updating the BIOS to prevent
system boot failure!

ASUS M2N-Plus SLI Vista Edition 4-5
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41.4 Updating the BIOS

The Basic Input/Output System (BIOS) can be updated using the AwardBIOS
Flash Utility. Follow these instructions to update the BIOS using this utility.

1. Download the latest BIOS file from the ASUS web site. Rename the file to
M2NPLUSSLI.BIN and save it to a floppy disk, CD ROM or a USB flash disk
in FAT 16/12 format.

R Save only the updated BIOS file in the disk to avoid loading the wrong BIOS file.

2. Copy the AwardBIOS Flash Utility (awdflash.exe) from the Software folder of
the support CD to the floppy disk, CD ROM or a USB flash disk with the latest
BIOS file.

3. Boot the system in DOS mode using the bootable floppy disk, CD ROM or a
USB flash disk you created earlier.

4. Under the DOS mode,
use <X:> (X stands for

the name of the disk For NF590-SLI-M2N-PLUS SLI DATE :03/30/2006
assignment) to switch to Flash Type - PMC Pm49FL004T LPC/FWH

the folder of floppy disk, — |RE— ]
CD ROM or USB flash
disk you saved the BIOS
fileand AwardBIOS Flash
Utility.

5- At 1he prompt J[ype Please input File Name!
awdflash then press
<Enter>. The Award BIOS
Flash Utility screen appears.

4-6 Chapter 4: BIOS setup
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6.  Type the BIOS file name in
the File Name to Program
fleld’ then press <Enter>. For NF590-SLI-M2N-PLUS SLI DATE:03/30/2006

Flash Type - PMC Pm49FL004T LPC/FWH

File Name to Program: [EZNZAENTEY

Do You Want To Save Bios (Y/N)

7.  Press <N>when the utility prompts you to save the current BIOS file. The
following screen appears.

8.  The utility verifies the BIOS
file in the floppy disk, CD
ROM or a USB flash disk For NF590-SLI-M2N-PLUS SLI DATE: 03/30/2006
and Starts f|aShIng the Flash Type - PMC Pm49FL004T LPC/FWH

BlOS f||e File Name to Program:

Programming Flash Memory - OFE00 OK
. Write OK No Update Write Fail

Warning:

% Do not turn off or reset the system during the flashing process!

9. The utility displays a
Flashing Complete

message indicating that For NF590-SLI-M2N-PLUS SLI DATE: 03/30/2006
you have successfully Flash Type - PMC Pm49FLO04T LPC/FWH

flashed the BIOS file. File Name to Program: W
Remove the disk then Flashing Complete

Press <F1> to Continue

press <F1> to restart the

. Write OK No Update Write Fail

-1
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4.1.5 Saving the current BIOS file

You can use the AwardBIOS Flash Utility to save the current BIOS file. You can
load the current BIOS file when the BIOS file gets corrupted during the flashing
process.

R Make sure that the floppy disk, CD ROM or a USB flash disk has enough disk
space to save the file.

To save the current BIOS file using the AwardBIOS Flash Utility:

1. Follow steps 1 to 6 of the
previous section.

2. Press <Y>when the utility
prompts you to save the

current BIOS file. The File Name to Program:
following screen appears. [[ESSEECSURILEEEHY |

For NF590-SLI-M2N-PLUS SLI DATE:03/30/2006
Flash Type - PMC Pm49FL004T LPC/FWH

3. Type afilename for the
current BIOS file in the
ave curren as fie For NF590-SLI-M2N-PLUS SLI DATE:03/30/2006
S t BIOS as field,
then press <Enter> Flash Type - PMC Pm49FL004T LPC/FWH

File Name to Program: [UiRPIN-EY

Checksum: 810DH

Save current BIOS as: [JNKNFEY

Please Wait!

4. The utility saves the
current BIOS file to the
disk, then returns to the For NF590-SLI-M2N-PLUS SLI DATE:03/30/2006
BlOS flashing process_ Flash Type - PMC Pm49FL004T LPC/FWH

File Name to Program: [UIREKINR.Y
Now Backup System BIOS to

File!

Please Wait!
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41.6  ASUS CrashFree BIOS 3 utility

The ASUS CrashFree BIOS 3 is an auto recovery tool that allows you to restore
the BIOS file when it fails or gets corrupted during the updating process. You can
update a corrupted BIOS file using the motherboard support CD, the floppy disk, or
the USB flash disk that contains the updated BIOS file.

R Prepare the motherboard support CD, the floppy disk or the USB flash disk
containing the updated motherboard BIOS before using this utility.

Recovering the BIOS from the support CD
To recover the BIOS from the support CD:

Turn on the system.
2. Insert the motherboard support CD to the optical drive.

3. The utility displays the following message and automatically checks the CD
for the BIOS file.

Award BootBlock BIOS v1.0
Copyright (c) 2000, Award Software, Inc.

BIOS ROM checksum error
Detecting IDE ATAPI device...

When found, the utility reads the BIOS file and starts flashing the corrupted
BIOS file.

Award BootBlock BIOS v1.0
Copyright (c) 2000, Award Software, Inc.

BIOS ROM checksum error
Detecting IDE ATAPI device...
Found CDROM, try to Boot from it... Pass

4. Restart the system after the utility completes the updating process.
Recovering the BIOS from the USB flash disk
To recover the BIOS from the USB flash disk:

1. Insert the USB flash disk that contains BIOS file to the USB port.
2. Turnon the system.

3. The utility will automatically checks the devices for the BIOS file When found,
the utility reads the BIOS file and starts flashing the corrupted BIOS file.

4. Restart the system after the utility completes the updating process.
Only the USB flash disk with FAT 32/16/12 format and single partition can

support ASUS CrashFree BIOS 3. The device size should be smaller than
8GB.

- D

DO NOT shut down or reset the system while updating the BIOS! Doing so
can cause system boot failure!
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4.2 BIOS setup program

This motherboard supports a programmable Low-Pin Count (LPC) chip that you
can update using the provided utility described in section “4.1 Managing and
updating your BIOS.”

Use the BIOS Setup program when you are installing a motherboard, reconfiguring
your system, or prompted to “Run Setup.” This section explains how to configure
your system using this utility.

Even if you are not prompted to use the Setup program, you can change the
configuration of your computer in the future. For example, you can enable the
security password feature or change the power management settings. This
requires you to reconfigure your system using the BIOS Setup program so that the
computer can recognize these changes and record them in the CMOS RAM of the
LPC chip.

The LPC chip on the motherboard stores the Setup utility. When you start up the
computer, the system provides you with the opportunity to run this program. Press
<Del> during the Power-On Self-Test (POST) to enter the Setup utility; otherwise,
POST continues with its test routines.

If you wish to enter Setup after POST, restart the system by pressing
<Ctri+Alt+Delete>, or by pressing the reset button on the system chassis. You can
also restart by turning the system off and then back on. Do this last option only if
the first two failed.

The Setup program is designed to make it as easy to use as possible. Being a
menu-driven program, it lets you scroll through the various sub-menus and make
your selections from the available options using the navigation keys.

R +  The default BIOS settings for this motherboard apply for most conditions
to ensure optimum performance. If the system becomes unstable after
changing any BIOS settings, load the default settings to ensure system
compatibility and stability. Select the Load Default Settings item under the
Exit Menu. See section 4.8 Exit Menu.

The BIOS setup screens shown in this section are for reference purposes
only, and may not exactly match what you see on your screen.

Visit the ASUS website (www.asus.com) to download the latest BIOS file for
this motherboard.

Chapter 4: BIOS setup
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4.2.1 BIOS menu screen

Menu items Menu bar Configuration fields General help

jERR. W Advanced Power Boot Tools Exit

System Time 15 : 30 : 36 Select Menu
System Date Thu, Apr 6 2006
Item Specific Helph
Legacy Diskette A: [1.44M, 3.5 in.] Change the internal
time.
»  Primary IDE Master [None]
» Primary IDE Slave [None]
» Secondary IDE Master [None]
> Secondary IDE Slave [None]
> SATA 1 [None]
> SATA 2 [None]
> SATA 3 [None]
> SATA 4 [None]
HDD SMART Monitoring [Disabled]
Installed Memory 512MB
Usable MemoryI 511MB
T
Sub-menu items Legend bar

4.2.2 Menu bar

The menu bar on top of the screen has the following main items:

Main For changing the basic system configuration

Advanced For changing the advanced system settings

Power For changing the advanced power management (APM)
configuration

Boot For changing the system boot configuration

Tools For configuring options for special functions

Exit For selecting the exit options and loading default
settings

To select an item on the menu bar, press the right or left arrow key on the keyboard
until the desired item is highlighted.

/ﬁ +  The BIOS setup screens shown in this chapter are for reference purposes
only, and may not exactly match what you see on your screen.

+  Visit the ASUS website (www.asus.com) to download the latest BIOS
information.
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4.2.3 Legend bar

At the bottom of the Setup screen is a legend bar. The keys in the legend bar allow
you to navigate through the various setup menus. The following table lists the keys
found in the legend bar with their corresponding functions.

Navigation Key Function

<F1> Displays the General Help screen

<F5> Loads setup default values

<Esc> Exits the BIOS setup or returns to the main menu from a
sub-menu

Left or Right arrow Selects the menu item to the left or right

Up or Down arrow Moves the highlight up or down between fields

Page Down or — (minus)  Scrolls backward through the values for the highlighted field

Page Up or + (plus) Scrolls forward through the values for the highlighted field
<Enter> Brings up a selection menu for the highlighted field
<F10> Saves changes and exit

4.2.4 Menu items

The highlighted item on the menu bar displays the specific items for that menu.
For example, selecting Main shows the Main menu items.

The other items (Advanced, Power, Boot, and Exit) on the menu bar have their
respective menu items.

4.2.5 Sub-menu items

A solid triangle before each item on any menu screen means that the item has a
sub-menu. To display the sub-menu, select the item and press <Enter>.

4.2.6 Configuration fields

These fields show the values for the menu items. If an item is user-configurable,
you can change the value of the field opposite the item. You cannot select an item
that is not user-configurable.

A configurable field is enclosed in brackets, and is highlighted when selected. To
change the value of a field, select it then press <Enter> to display a list of options.
Refer to “4.2.7 Pop-up window.”
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4.2.7 Pop-up window

Select a menu item then press <Enter> to display a pop-up window with the
configuration options for that item.

m Advanced Power Boot Tools Exit

System Time 15 : 30 : 36 Select Menu
System Date Thu, Apr 6 2006

Item Specific Help;

Legacy Diskette i cifies the capacity
. Legacy Diskette A: physical size of

Primary IDE kette drive A.

Primary IDE Disabled  ..... [1]

Secondary ID 720K , 3.5 in.  ..... [

Secondary ID 1.44M, 3.5 in

SATA 1 T ’

SATA 2

SATA 3

SATA 4

HDD SMART Mo

VVVVVVYVYYVY

Installed Me 1] :Move ENTER:Accept ESC:Abort

Usable Memor;

Pop-up menu

4.2.8 General help

At the top right corner of the menu screen is a brief description of the selected
item.
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4.3 Main menu

When you enter the BIOS Setup program, the Main menu screen appears, giving
you an overview of the basic system information.

Refer to section 4.2.1 BIOS menu screen for information on the menu screen
items and how to navigate through them.

m Advanced Power Boot Tools Exit

System Time 15 : 30 : 36 Select Menu
System Date Thu, Apr 6 2006
Item Specific Helph

Legacy Diskette A: [1.44M, 3.5 in.] Change the internal
» Primary IDE Master [None] G
» Primary IDE Slave [None]
» Secondary IDE Master [None]
P> Secondary IDE Slave [None]
P SATA 1 [None]
> SATA 2 [None]
> SATA 3 [None]
> SATA 4 [None]

HDD SMART Monitoring [Disabled]

Installed Memory 512MB

Usable Memory 511MB

4.31 System Time [xx:xx:xx]

Allows you to set the system time.

4.3.2 System Date [Day xx/xx/xxxx]

Allows you to set the system date.

4.3.3 Legacy Diskette A [1.44M, 3.5 in.]

Sets the type of floppy drive installed.
Configuration options: [Disabled] [720K , 3.5 in.] [1.44M, 3.5 in.]
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4.3.4  Primary/Secondary IDE Master/Slave

While entering Setup, the BIOS automatically detects the presence of IDE devices.
There is a separate sub-menu for each IDE device. Select a device item then
press <Enter> to display the IDE device information.

Main
Primary IDE Master Select Menu

Primary IDE Master [Auto] Item Specific Helphd

Access Mode [Auto]
Press [Enter] to
select.

Capacity 0 GB

Cylinder 0

Head 0

Sector 0

PIO Mode [Auto]

UDMA Mode [Auto]

Transfer Mode None

The BIOS automatically detects the values opposite the dimmed items
(Capacity, Cylinder, Head, Sector and Transfer Mode). These values are not
user-configurable. These items show N/A if no IDE device is installed in the
system.

Primary/Secondary IDE Master/Slave [Auto]

Select [Auto] to automatically detect an IDE hard disk drive. If automatic detection
is successful, the BIOS automatically fills in the correct values for the remaining
fields on this sub-menu. If the hard disk was already formatted on a previous
system, the setup BIOS may detect incorrect parameters. Select [Manual] to
manually enter the IDE hard disk drive parameters. If no drive is installed select

[None]. Configuration options: [None] [Auto] [Manual]

Access Mode [Auto]

The default [Auto] allows automatic detection of an IDE hard disk drive.
Select [CHS] for this item if you set the IDE Primary Master/Slave to [Manual].
Configuration options: [CHS] [LBA] [Large] [Auto]

) ' Before attempting to configure a hard disk drive, make sure you have the
e correct configuration information supplied by the drive manufacturer. Incorrect
settings may cause the system to fail to recognize the installed hard disk.
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Capacity
Displays the auto-detected hard disk capacity. This item is not configurable.

Cylinder
Shows the number of the hard disk cylinders. This item is not configurable.

Head
Shows the number of the hard disk read/write heads. This item is not configurable.

Sector
Shows the number of sectors per track. This item is not configurable.

P10 Mode [Auto]

Sets the PIO mode for the IDE device.

Configuration options: [Auto] [Mode 0] [Mode 1] [Mode 2] [Mode 3] [Mode 4]
UDMA Mode [Auto]

Disables or sets the UDMA mode. Configuration options: [Disable] [Auto]

Transfer Mode
Shows the Transfer mode. This item is not configurable.

% After entering the IDE hard disk drive information into BIOS, use a disk utility,

& such as FDISK, to partition and format new IDE hard disk drives. This is
necessary so that you can write or read data from the hard disk. Make sure to
set the partition of the Primary IDE hard disk drives to active.
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435  SATA1~4

While entering Setup, the BIOS automatically detects the presence of Serial ATA
devices. There is a separate sub-menu for each SATA device. Select a device item
then press <Enter> to display the SATA device information.

Main
SATA 1 Select Menu
Extended IDE Drive [Auto] Item Specific Helphh
Access Mode [Auto]

Selects the type of
Capacity 0 MB fixed disk connected
to the system.
Cylinder
Head
Landing Zone
Sector

ocococo

The BIOS automatically detects the values opposite the dimmed items
(Capacity, Cylinder, Head, Landing Zone and Sector). These values are not user-
configurable. These items show 0 if no SATA device is installed in the system.

Extended IDE Drive [Auto]
Selects the type of fixed disk connected to the system.
Configuration options: [None] [Auto]

Access Mode [Auto]
Sets the sector addressing mode. Configuration options: [Large] [Auto]

% Before attempting to configure a hard disk drive, make sure you have the
e correct configuration information supplied by the drive manufacturer. Incorrect
settings may cause the system to fail to recognize the installed hard disk.

Capacity
Displays the auto-detected hard disk capacity. This item is not configurable.

Cylinder
Shows the number of the hard disk cylinders. This item is not configurable.
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Head
Shows the number of the hard disk read/write heads. This item is not configurable.

Landing Zone
Shows the number of landing zone per track. This item is not configurable.

Sector
Shows the number of sectors per track. This item is not configurable.

% After entering the IDE hard disk drive information into BIOS, use a disk utility,
such as FDISK, to partition and format new IDE hard disk drives. This is
necessary so that you can write or read data from the hard disk. Make sure to

set the partition of the Primary IDE hard disk drives to active.

4.3.6 HDD SMART Monitoring [Disabled]

Allows you to enable or disable the HDD Self-Monitoring Analysis and Reporting
Technology (SMART) feature. Configuration options: [Disabled] [Enabled]

4.3.7 Installed Memory [xxx MB]

Shows the size of installed memory.

4.3.8 Usable Memory [ XXX MB]

Shows the size of usable memory.
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4.4 Advanced menu

The Advanced menu items allow you to change the settings for the CPU and other
system devices.

/ ' \ Take caution when changing the settings of the Advanced menu items. Incorrect
— field values can cause the system to malfunction.

Main [GUCLEEGEN Power Boot  Tools Exit
»  JumperFree Configuration Select Menu
» CPU Configuration Item Specific Helph
» PCIPnP n
. . . Adjust system
» Onboard Device Configuration
» SLI Configuration frequency/voltage.

441 JumperFree Configuration

Advanced
JumperFree Configuration Select Menu
AI Tuning . [Auto] Item Specific Helphp
Overclock Options Disabled
N.O.S. Option Disabled Press [Enter] to

CPU Frequency Auto
PCI Express Clock Auto OO el
DDR2 Voltage Control Auto profile.

PCI Clock Synchronization Mode Auto

MMM XXX
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Al Tuning [Auto]

Allows selection of CPU overclocking options to achieve desired CPU internal
frequency. Selct either one of the preset overclocking configuration options:

Manual Allows you to individually set overclocking parameters.
Auto Loads the optimal settings for the system.

Standard Loads the standard settings for the system.

Al Overclock Loads overclocking profiles with optimal parameters for

stability when overclocking.

/ The following item becomes user-configurable when you set Al Tuning to
L [Al Overclock].

Overclock Options [Disabled]

Allows you to set the overclocking options.
Configuration options: [Disabled] [Overclock 3%] [Overclock 5%)] [Overclock 8%)]
[Overclock 10%)]

% The following item becomes user-configurable when you set Al Tuning to
& [Manual]

CPU Frequency [XXX] (value is auto-detected)

Indicates the frequency sent by the clock generator to the system bus and PCI
bus. The bus frequency (external frequency) multiplied by the bus multiple equals
the CPU speed. The BIOS auto-detects the value of this item. The values range
from 200.0 to 400.0.

' Setting a very high CPU frequency may cause the system to become unstable.
= If this happens, revert to the default setting.

PCI Express Clock [100Mhz]

Allows you to set the PCI Express clock.
Configuration options: [100MHz]~[145MHz]

DDR2 Voltage [Auto]

Allows you to set the operating DDR2 voltage.
Configuration options: [Auto] [1.80V] [1.85V] [1.90V] [1.95V]

PCI Clock Synchronization Mode [Auto]

Sets the PCI Clock Synchronization mode.
Configuration options: [Auto] [To CPU] [33.33MHz]
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44.2 CPU Configuration

Advanced
CPU Configuration Select Menu
CPU Type AMD Sempron(tm) Processor 3000+ Item Specific Helph
CPU Speed 1600 MH DRAM timing and
pee: z
Cache RAM 256K Con ol
> DRAM Configuration
Hyper Transport Frequency [Auto]
AMD Live! [Disabled]
AMD Cool ‘n’ Quiet Function [Disabled]

DRAM Configuration

The items in the sub-menu show the DRAM-related information auto-detected by
the BIOS.

Advanced
DRAM Configuration Select Menu
Memory Clock Frequency [Auto] i P>
» DRAM Timing Control ZtepiSpecificpsl
:iid :ﬁzg Setting platform
Trp Auto Memclock or limit
Tras Auto value.
{Exc Auto
Twr Auto
Trrd Auto
Trwt Auto
Twtr Auto
Trtp Auto
Twrrd Auto
TWIrwr Auto
Trdrd Auto
Trfc Auto
1T/2T Memory Timing [Auto]

Memory Clock Fr ney [Aut

Sets the memory clock frequency.

Configuration options: [Auto] [DDR2 400] [DDR2 533] [DDR2 667]
[DDR2 800]
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DRAM Timing Control

_

DRAM Timing Control Select Menu
Load Fail-Safe Defaults ifi
e 0 Item Specific Helphh»
gi:g::g “one g Load Fail-Safe
Landing Zone 0 Defaults
Precomp 0
Landing Zone 0
Precomp 0
Landing Zone 0
USB Keyboard Support [Disabled]
USB Mouse Support [Disabled]
Precomp 0
x Power On By Button Enabeld
Onboard FDC controller [Enabled]
CKE Fine Delay [Auto]
CKE Setup Time [Auto]
CS/ODT Fine Delay [Auto]

Load Fail-Safe Defaults
Configuration options: [YES] [NO]

USB Keyboard Support [Disabled]
Configuration options: [Disabled] [Enabled]

USB Mouse Support [Disabled]
Configuration options: [Disabled] [Enabled]

Onboard FDC Controller [Enabled]
Configuration options: [Disabled] [Enabled]

CKE Fine Delay [Auto]

Configuration options: [Auto] [No delay] [1/64 MEMCLK delay] [2/64 MEMCLK
delay] [3/64 MEMCLK delay] [4/64 MEMCLK delay] [5/64 MEMCLK delay]~[30/64
MEMCLK delay] [31/64 MEMCLK delay]

CKE Setup Time [Auto]
Configuration options: [Auto] [1/2 MEMCLK] [1 MEMCLK]

CS/0DT Fine Delay [Auto]

Configuration options: [Auto] [No delay] [1/64 MEMCLK delay] [2/64 MEMCLK
delay] [3/64 MEMCLK delay] [4/64 MEMCLK delay] [5/64 MEMCLK delay]~[30/64
MEMCLK delay] [31/64 MEMCLK delay]

CS/ODT Setup Time [Auto]
Configuration options: [Auto] [1/2 MEMCLK] [1 MEMCLK]

Address/Command Fine Delay [Auto]

Configuration options: [Auto] [No delay] [1/64 MEMCLK delay] [2/64 MEMCLK
delay] [3/64 MEMCLK delay] [4/64 MEMCLK delay] [5/64 MEMCLK delay]~[30/64
MEMCLK delay] [31/64 MEMCLK delay]

Address/Command Setup Time [Auto]
Configuration options: [Auto] [1/2 MEMCLK] [1 MEMCLK]
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Tcl [Auto]
Configuration options: [Auto] [3] [4] [5] [6]

Tred [Auto]
Configuration options: [Auto] [3] [4] [5] [6]

Trp [Auto]
Configuration options: [Auto] [3] [4] [5] [6]

Tras [Auto]
Configuration options: [Auto] [5] [6] [7]~[18]

Trc [Auto]
Configuration options: [Auto] [11] [12] [13]~[25] [26]

Twr [Auto]
Configuration options: [Auto] [3] [4] [5] [6]

Trrd [Auto]
Configuration options: [Auto] [2] [3] [4] [5]

Trwt [Auto]
Configuration options: [Auto] [2] [3] [4] [5] [6] [7] [8] [9]

Twtr [Auto]
Configuration options: [Auto] [1] [2] [3]

Trto [Auto]
Configuration options: [Auto] [2/4] [3/5]

Twrrd [Auto]
Configuration options: [Auto] [0] [1] [2] [3]

Twrwr [Auto]
Configuration options: [Auto] [1] [2] [3]

Trdrd [Auto]
Configuration options: [Auto] [2] [3] [4] [5]

Trfc [Auto]
Configuration options: [Auto] [0] [1] [2] [3]

17/2T Memory Timing [Auto]
Sets the memory timing. Configuration options: [Auto] [1T] [2T]

Hyper Transport Frequency [Auto]
Configuration options: [1x] [2x] [3x] [4x] [5x] [Auto]

AMD Live! [Disabled]

Enables or disables the AMD Live! technology.
Configuration options: [Disabled] [Enabled]
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AMD Cool ‘n’ Quiet Function [Disabled]

Enables or disables the AMD Cool ‘n’ Quiet technology.
Configuration options: [Auto] [Disabled]

443 PCIPnP

_

PCIPnP Select Menu
Plug & Play 0/S [No] Item Specific Helphp
Primary Display Adapter [pCI] Select Yes if you are using

a Plug and Play capable
operating system. Select
No if you need the BIOS to
configure non-boot devices.

Plug & Play O/S [No]

When set to [No], the BIOS configures all the devices in the system. When set to
[Yes] and if you install a Plug and Play operating system, the operating system
configures the Plug and Play devices not required for boot.

Configuration options: [No] [Yes]

Primary Display Adapter [PCI]
Allows selection of graphics controller to use as the primary boot device.
Configuration options: [PCI] [PCI-E]

444 Onboard Device Configuration

_

Onboard Device Configuration Select Menu

» IDE Function Setup 5
> NVRAID Configuration BT BFERHD Feiip>
» USB Configuration

Onboard nvidia LAN [Enabled] Press [Enter] to set.

Onboard LAN Boot ROM [Disabled]

Onboard USB Audio [Enabled]

ASUS ASAP [Disabled]

Onboard 1394 [Enabled]

Serial Portl Address [3F8/IRQ4]

Parallel Port Address [378/IRQ7]

Parallel Port Mode [EPP]
x ECP Mode Use DMA 3
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IDE Function Setup

This sub-menu contains IDE function-related items. Select an item then press
<Enter> to edit.

_

IDE Function Setup Select Menu
OnChip IDE Channel0 [Enabled] Item Specific Helphhd
OnChip IDE Channell [Enabled]
IDE DMA transfer access [Enabled] Di le/E 1 TS
SATA Port 1,2 [Enabled] I;:aléhe/ nil; e Onchip
SATA DMA transfer [Enabled] anne
SATA Port 3,4 [Enabled]
SATA2 DMA transfer [Enabled]
IDE Prefetch Mode [Enabled]

OnChip IDE Channel0 [Enabled]
Allows to disable or enable OnChip IDE Channel0
Configuration options: [Disabled] [Enabled]

OnChip IDE Channel1 [Enabled]
Allows to disable or enable OnChip IDE Channel1
Configuration options: [Disabled] [Enabled]

IDE DMA transfer access [Enabled]
Allows to disable or enable IDE DMA transfer access
Configuration options: [Disabled] [Enabled]

SATA Port 1, 2 [Enabled]
Allows to disable or enable OnChip SATA(Port 1, Port 2)
Configuration options: [Disabled] [Enabled]

SATA DMA transfer [Enabled]
Allows to disable or enable to switch to support SATA DMA tranfer
Configuration options: [Disabled] [Enabled]

SATA Port 3, 4 [Enabled]
Allows to disable or enable OnChip SATA2(Port 3, Port 4)
Configuration options: [Disabled] [Enabled]

SATA2 DMA transfer [Enabled]
Allows to disable or enable to switch to support SATA2 DMA tranfer
Configuration options: [Disabled] [Enabled]
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IDE Prefetch Mode [Enabled]
Allows to disable or enable IDE PIO read prefetch mode. When prefetch is
enabled, either 16-bit or 32-bit are allowed on IDE bus.
Configuration options: [Disabled] [Enabled]
NVRAID Configuration

This item in this sub-menu allows you to set up RAID feature.

_

NVRAID Configuration Select Menu
RAID Enable [Disabled] Item Specific Helph»
X SATA 1 RAID Disabled
x SATA 2 RAID Disabled Disable.Enable nVIDIA
x SATA 3 RAID Disabled = t
x SATA 4 RAID Disabled eture.
RAID Enable [Disabled]

Allows to disable or enable nVIDIA RAID feature.
Configuration options: [Disabled] [Enabled]

% The following items are user-configurable only when the RAID Enable item is
o set to [Enabled].

SATA 1 RAID [Disabled]
Selects this device as RAID set.
Configuration options: [Disabled] [Enabled]

SATA 2 RAID [Disabled]
Selects this device as RAID set.
Configuration options: [Disabled] [Enabled]

SATA 3 RAID [Disabled]
Selects this device as RAID set.
Configuration options: [Disabled] [Enabled]

SATA 4 RAID [Disabled]
Selects this device as RAID set.
Configuration options: [Disabled] [Enabled]
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USB Configuration

The items in this menu allows you to change the USB-related features. Select an
item then press <Enter> to display the configuration options.

_

USB Configuration Select Menu
USB Controller [Enabled] Item Specific Helphh
USB2.0 Controller [Enabled]
USB Legacy support [Enabled] Enable or Disable USB 1.1
and 2.0 Controller.

USB Controller [Enabled]
Allows you to enable or disable the onchip USB controller.
Configuration options: [Disabled] [Enabled]

% When USB Controller is set to [Disabled], both USB 2.0 Controller and USB
~ Legacy support will be disabled.

USB 2.0 Controller [Enabled]
Allows you to enable or disable the USB 2.0 controller.
Configuration options: [Disabled] [Enabled]

% When USB 2.0 Controller is set to [Disabled], audio function will be disabled.
USB Legacy Support [Enabled]
Allows you to enable or disable support for USB devices on legacy operating
systems (OS). Configuration options: [Disabled] [Enabled]

Onboard nVidia LAN [Enabled]

Enable or Disable Onboard NV LAN Interface.
Configuration options: [Enabled] [Disabled]

Onboard LAN Boot ROM [Disabled]

Enable or Disable the bootrom of the onboard LAN.
Configuration options: [Enabled] [Disabled]

Onboard USB Audio [Enabled]

Enable or Disable Onboard USB Audio.
Configuration options: [Enabled] [Disabled]

ASUS ASAP [Disabled]

Allows you to enable or disable the onboard USB flash module for the ASUS ASAP
feature that supports Windows® Vista ReadyBoost™ function.
Configuration options: [Disabled] [Enabled]
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Onboard 1394 [Enabled]

Enable or Disable Onboard 1394.
Configuration options: [Enabled] [Disabled]

Serial Port1 Address [3F8/IRQ4]

Allows you to select the Serial Port1 base address.
Configuration options: [Disabled] [3F8/IRQ4] [2F8/IRQ3] [3E8/IRQ4] [2E8/IRQ3]
[Auto]

Parallel Port Address [378/IRQ7]

Allows you to select the Parallel Port base addresses.
Configuration options: [Disabled] [378/IRQ7] [278/IRQ5] [3BC/IRQ7]

Parallel Port Mode [EPP]

Allows you to select the Parallel Port mode.
Configuration options: [Normal] [EPP] [ECP] [Bi-Directional]

/ The ECP Mode Use DMA item becomes user-configurable when the Parallel
~ Port Mode item is set to [ECP] or [Bi-Directional]

ECP Mode Use DMA [3]
Allows selection of ECP Mode. Configuration options: [1] [3]

4.4.5 SLI Configuration

SLI Configuration Select Menu

AI-Selector [Auto] Item Specific Helphhh

Allow you to select
the Scalable Link
Interface mode. When
set to Auto, BIOS
detects the setting of
SLI EZ Selector Card.
Set to Normal when
using single PCI-E
graphics card plugged.

Al-Selector[Auto]

Allows you to select the Scalable Link Interface mode. When set to [Auto], BIOS
detects the setting of SLI EZ Selector Card. Set this item to [Single Video Card]
when using single PCI-E graphics card.

Configuration: [Auto] [Single Video Card] [Dual Video Card]
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4.5 Power menu

The Power menu items allow you to change the settings for the Advanced
Configuration and Power Interface (ACPI) and the Advanced Power Management
(APM). Select an item then press <Enter> to display the configuration options.

Main Advanced E:ULIgl Boot  Tools Exit
ACPI Suspend Type [S1&S3] Select Menu
ACPI APIC support [Enabled]
APM Configuration Item Specific Helph

vwv

Hardware Monitor
Select the ACPI state
used for System
Suspend.

451 ACPI Suspend Type [S1&S3]

Allows you to select the Advanced Configuration and Power Interface (ACPI) state
to be used for system suspend.
Configuration options: [S1(POS)] [S3(STR)] [S1&S3]

45.2 ACPI APIC Support [Enabled]

Allows you to enable or disable the Advanced Configuration and Power Interface
(ACPI) support in the Advanced Programmable Interrupt Controller (APIC). When
set to Enabled, the ACPI APIC table pointer is included in the RSDT pointer list.
Configuration options: [Disabled] [Enabled]
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453  APM Configuration

_

APM Configuration Select Menu

Restore on AC Power Loss [Power-Off] Item Specific Helphh

PWR Button < 4 secs [Instant-Off]

Power Up On PCI/PCIE Devices [Disabled]

Power On By External Modems [Disabled] Press [Enter] to

Power On by RTC Alarm [Disabled] select whether or not
x Date(of Month) Alarm 0 to restart the system
X Alarm Time (hh:mm:ss) 0:0:0 after AC power loss.

HPET Support [Enabled]

Power Up By PS/2 Mouse [Disabled]

Power Up By PS/2 Keyboard [Disabled]

Restore on AC Power Loss [Power-Off]

Allows you to enable or disable the Restore on AC Power Loss function.
Configuration options: [Power-Off] [Power-On]

PWR Button < 4 secs [Instant-Off]

Allows you to set the event after the power button is pressed for more than 4
seconds. Configuration options: [Suspend] [Instant-Off]

Power Up On PCI/PCIE Devices [Disabled]

Allows you to enable or disable the PME to wake up from S5 by PCI/PCIE devices
& NV Onboard LAN. Configuration options: [Disabled] [Enabled]

Power On By External Modems [Disabled]

This allows either settings of [Enabled] or [Disabled] for powering up the computer
when the external modem receives a call while the computer is in Soft-off mode.
Configuration options: [Disabled] [Enabled]

% The computer cannot receive or transmit data until the computer and

~ applications are fully running. Thus, connection cannot be made on the first
try. Turning an external modem off and then back on while the computer is off
causes an initialization string that turns the system power on.

Power On By RTC Alarm [Disabled]
Allows you to enable or disable RTC to generate a wake event. When this item is
set to [Enabled], the items “Date (of Month) Alarm” and “Alarm Time (hh:mm:ss)”
become user-configurable with set values.
Configuration options: [Disabled] [Enabled]
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Date (of Month) Alarm [xx]

To set the date of alarm, highlight this item then press <+> or <-> to make the
selection (Min=0; Max=31).

Alarm Time (hh:mm:ss) [xx:xx:xx]

To set the time of alarm, use <Tab> or < ->/ < —> to select a field, then press <+>
or <->to make the selection (Min=0, Max=23 for the hour field; Min=0, Max=59 for
the minutes/seconds field).

HPET Support [Enabled]
Configuration options: [Disabled] [Enabled]

Power Up By PS/2 Mouse [Disabled]

When set to [Enabled], this parameter allows you to use the PS/2 mouse to turn on
the system. This feature requires an ATX power supply that provides at least 1A on
the +5VSB lead. Configuration options: [Disabled] [Enabled]

Power Up By PS/2 Keyboard [Disabled]

Allows you to disable the Power On by PS/2 keyboard function or set specific keys
on the PS/2 keyboard to turn on the system. This feature requires an ATX power
supply that provides at least 1A on the +5VSB lead.

Configuration options: [Disabled] [Space Bar] [Ctrl-ESC] [Power Key]
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454 Hardware Monitor

The items in this sub-menu displays the hardware monitor values automatically
detected by the BIOS. It also allows you to change CPU Q-Fan feature-related
parameters. Select an item then press <Enter> to display the configuration options.

Power

Hardware Monitor Select Menu
CPU Q-Fan Control [Disabled] Item Specific Helphh
x CPU Q-Fan Profile Performance
Chassis Q-Fan Control [Disabled]

x Chassis Q-Fan Profile Performance Press [Enter] to

Vcore Voltage [ 1.39V] enable or disable.
3.3V Voltage [ 2.76V]

5V Voltage [ 4.48V]

12V Voltage [11.32V]

CPU Temperature 30°C

M/B Temperature 33°c

CPU FAN Speed 2884 RPM

CHASSIS FAN Speed 0 RPM

POWER FAN Speed 0 RPM

CPU Fan Speed warning [ 800 RPM]

CPU Q-Fan Control [Disabled]

Allows you to enable or disable the CPU Q-Fan controller.
Configuration options: [Disabled] [Enabled]

% The CPU Q-Fan Profile item becomes use-configurable when you enable the
- CPU Q-Fan Control item.

CPU Q-Fan Profile [Performance]

Allows you to set the appropriate performance level of the CPU Q-Fan. When
set to [Optimal], the CPU fan automatically adjusts depending on the CPU
temperature. Set this item to [Silent] to minimize fan speed for quiet CPU fan
operation, or [Performance] to achieve maximum CPU fan speed.
Configuration options: [Performance] [Optimal] [Silent]

Chassis Q-Fan Control [Disabled]
Allows you to enable or disable the chassis Q-Fan controller.
Configuration options: [Disabled] [Enabled]

/ The succeeding item becomes user-configurable when you set the Chassis
~ Q-Fan Control item to [Enabled].

Chapter 4: BIOS setup
Download from Www.Somanuals.com. All Manuals Search And Download.



Chassis Q-Fan Profile [Performance]

Allows you to set the appropriate performance level of the chassis Q-Fan. When
set to [Optimal], the chassis fan automatically adjusts depending on the chassis
temperature. Set this item to [Silent] to minimize fan speed for quiet chassis fan
operation, or [Performance] to achieve maximum chassis fan speed.
Configuration options: [Performance] [Optimal] [Silent]

Vcore Voltage, 3.3V Voltage, 5V Voltage, 12V Voltage

The onboard hardware monitor automatically detects the voltage output through
the onboard voltage regulators. Select [Ignored] if you do not want to detect this
item.

CPU Temperature, M/B Temperature

The onboard hardware monitor automatically detects and displays the motherboard
and CPU temperatures. These items are not user-configurable.

CPU Fan Speed

CHASSIS FAN Speed

POWER FAN Speed

The onboard hardware monitor automatically detects and displays the CPU,
chassis, and power fan speeds in rotations per minute (RPM). If any of the fans is
not connected to the motherboard, the field shows 0. These items are not user-
configurable.

CPU Fan Speed warning [ 800 RPM]

Allows you to disable or set the CPU fan warning speed.
Configuration options: [Disabled] [800 RPM] [1200 RPM] [1600 RPM]
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4.6 Boot menu

The Boot menu items allow you to change the system boot options. Select an item
then press <Enter> to display the sub-menu.

Main Advanced ©Power [R:LIJ8l Tools Exit
» Boot Device Priority Select Menu
» Removable Drives
» Hard Disk Drives Item Specific Helph
» CDROM Drives
» Boot Settings Configuration Select Boot Device
» Security Priority

4.6.1 Boot Device Priority

Boot Device Priority Select Menu
1st Boot Device [Removable] Item Specific Helphp
2nd Boot Device [Hard Disk]
3rd Boot Device [CDROM]

Select Your Boot

4th Boot Device [Disabled] N o
Device Priority

1st ~ 4th Boot Device [Removable]
These items specify the boot device priority sequence from the available devices.
The number of device items that appears on the screen depends on the number of

devices installed in the system.
Configuration options: [Removable] [Hard Disk] [CDROM] [Disabled]
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4.6.2 Removable Drives

m

Removable Drives Select Menu

1. Floppy Disks Item Specific Helphp

1. Floppy Disks
Allows you to assign a removable drive attached to the system.

4.6.3 Hard Disk Drives

00

Hard Disk Drives Select Menu

1. SATAL: XXXXXXXXX Item Specific Helphh

1. SATA1: XXXXXXXXX
Allows you to assign hard disk drives attached to the system.

4.6.4 CDROM Drives

00

CDROM Drives Select Menu

1. 1st Slave: XXXXXXXXX Item Specific Helph»

1. 1st Slave: XXXXXXXXX
Allows you to assign optical drives attached to the system.
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4.6.5 Boot Settings Configuration

m

Boot Settings Configuration Select Menu
Case Open Warning [Enabled] Item Specific HelphP
Quick Boot [Enabled]
Boot Up Floppy Seek [Disabled]
Bootup Num-Lock [On] Press [Enter] to
Typematic Rate Setting [Disabled] enable or disable.
x Typematic Rate (Chars/Sec) 6
x Typematic Delay (Msec) 250
0S Select For DRAM > 64MB [Non-082]
Full Screen LOGO [Enabled]
Halt On [All, But Keyboard]

Case Open Warning [Enabled]

Enables or disables the chassis open status feature. Setting to [Enabled] clears
the chassis open status. Refer to section “2.7.2 Internal connectors” for details.
Configuration options: [Disabled] [Enabled]

Quick Boot [Enabled]

Allows you to enable or disable the system quick boot feature. When set to
[Enabled], the system skips certain tests while booting.
Configuration options: [Disabled] [Enabled]

Boot Up Floppy Seek [Disabled]

Enables or disables the floppy seek feature while booting.
Configuration options: [Disabled] [Enabled]

Bootup Num-Lock [On]

Allows you to select the power-on state for the NumLock.
Configuration options: [Off] [On]

Typematic Rate Setting [Disabled]

Allows you to set the keystroke rate. Enable this item to configure the Typematic
Rate (Chars/Sec) and the Typematic Delay (Msec).
Configuration options: [Disabled] [Enabled]

/ The items Typematic Rate (Chars/Sec) and Typematic Delay (Msec) become
- user-configurable when the item Typematic Rate Setting is enabled.
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Typematic Rate (Chars/Sec) [6]

Allows you to select the rate at which a character repeats when you hold a key.
Configuration options: [6] [8] [10] [12] [15] [20] [24] [30]

Typematic Delay (Msec) [250]

Allows you to set the delay before keystrokes begin to repeat.

Configuration options: [250] [500] [750] [1000]

OS Select for DRAM > 64MB [Non-0S2]

Set this item to OS2 only when you are running on an OS/2 operating system with
an installed RAM of greater than 64 KB. Configuration options: [Non-OS2] [0S2]

Full Screen LOGO [Enabled]

Allows you to enable or disable the full screen logo display feature.
Configuration options: [Disabled] [Enabled]

/ Make sure that the above item is set to [Enabled] if you want to use the ASUS
~ MyLogo2™ feature.

Halt On [All, But Keyboard]

Allows you to error report type.
Configuration options: [All Errors] [No Errors] [All, But Keyboard] [All, But Diskette]
[All, But Disk/Key]

4.6.6  Security

m

Security Select Menu
Supervisor Password Clear Item Specific Helph»
User Password Clear
Password Check [Setup]
Security Chip [Disabled] Supervisoripassnord

controls full access,
<Enter> to change
password.

Supervisor Password
User Password

These fields allow you to set passwords:
To set a password:

1. Select an item then press <Enter>.

2. Type in a password using a combination of a maximum of eight (8) alpha-
numeric characters, then press <Enter>.
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3. When prompted, confirm the password by typing the exact characters again,
then press <Enter>. The password field setting is changed to Set.

To clear the password:

1. Select the password field and press <Enter> twice. The following message
appears:

PASSWORD DISABLED !!!
Press any key to continue...
2. Press any key to continue. The password field setting is changed to Clear.

A note about passwords

The Supervisor password is required to enter the BIOS Setup program
preventing unauthorized access. The User password is required to boot the
system preventing unauthorized use.

Forgot your password?

If you forget your password, you can clear it by erasing the CMOS Real Time
Clock (RTC) RAM. The RAM data containing the password information is
powered by the onboard button cell battery. If you need to erase the CMOS
RAM, refer to section “2.6 Jumper” for instructions.

Password Check

This field requires you to enter the password before entering the BIOS setup or the
system. Select [Setup] to require the password before entering the BIOS Setup.
Select [System] to require the password before entering the system.

Configuration options: [Setup] [System]

Security Chip [Disabled]

Allows you to enable or disable the TPM security chip.
Configuration options: [Disabled] [Enabled]

/ The succeeding item appears when you enable the Security Chip item.
Clear TPM Security Chip [Enter]
Allows you to clear the user information saved in the TPM security chip.
When you press <Enter>, a warning message appears to ask if you want to
clear the user information in the security chip. Use the left/right arrow key to
select between [YES] and [NO], then press <Enter> to confirm your choice.

. After you select [YES] to execute the Clear TPM Security Chip function, the
e data saved in the TPM security chip will be cleared and can never be restored.
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4.7 Tools menu

The Tools menu items allow you to configure options for special functions. Select
an item then press <Enter> to display the sub-menu.

Main Advanced Power Boot [ReldEd Exit

ASUS EZ Flash 2 Select Menu

Item Specific Help;

Press Enter to Run
ASUS EZ Flash 2

4.71 ASUS EZ Flash 2

Allows you to run ASUS EZ Flash 2. When you press <Enter>, a confirmation
message appears. Use the left/right arrow key to select between [Yes] or [No],
then press <Enter> to confirm your choice. Please see page 4-5, section 4.1.3 for
details.

ASUSTek EZ Flash 2 BIOS ROM Utility B318
FLASH TYPE: PMC Pm49FL004T LPC/FWH

Current ROM Update ROM
BOARD: M2N-PLUS SLI BOARD: Unknown
VER: 0104 VER: Unknown
DATE: 12/20/2006 DATE: Unknown

PATH: A:\

1

Note
[Enter] Select [S] Save [ESC] Exit

[Tab] Switch [Up/Down/Home/End] Move
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4.8 Exit menu

The Exit menu items allow you to load the optimal or failsafe default values for the
BIOS items, and save or discard your changes to the BIOS items.

Main Advanced Power Boot Tools B®SEd

Exit & Save Changes Select Menu
Exit & Discard Changes N
Load Setup Default Item Specific Helph

Discard Changes
This option save data
to CMOS and exiting
the setup menu.

% Pressing <Esc> does not immediately exit this menu. Select one of the options
~ from this menu or <F10> from the legend bar to exit.

Exit & Save Changes

Once you are finished making your selections, choose this option from the Exit
menu to ensure the values you selected are saved to the CMOS RAM. An onboard
backup battery sustains the CMOS RAM so it stays on even when the PC is turned
off. When you select this option, a confirmation window appears. Select [YES] to
save changes and exit.

% If you attempt to exit the Setup program without saving your changes, the
- program prompts you with a message asking if you want to save your changes
before exiting. Press <Enter> to save the changes while exiting.

Exit & Discard Changes

Select this option only if you do not want to save the changes that you made to the
Setup program. If you made changes to fields other than System Date, System
Time, and Password, the BIOS asks for a confirmation before exiting.

Load Setup Defaults

This option allows you to load the default values for each of the parameters on the
Setup menus. When you select this option or if you press <F5>, a confirmation
window appears. Select [YES] to load default values. Select [Exit & Save Changes]
or make other changes before saving the values to the non-volatile RAM.

Discard Changes

This option allows you to discard the selections you made and restore the
previously saved values. After selecting this option, a confirmation appears. Select
[YES] to discard any changes and load the previously saved values.
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5.1 Installing an operating system

This motherboard supports Windows® 2000/XP/64-bit XP/Vista/64-bit Vista
operating systems (OS). Always install the latest OS version and corresponding
updates to maximize the features of your hardware.

/ + Motherboard settings and hardware options vary. Use the setup
procedures presented in this chapter for reference only. Refer to your OS
documentation for detailed information.

+ Make sure that you install Windows® 2000 Service Pack 4 or the Windows®
XP Service Pack2 or later versions before installing the drivers for better
compatibility and system stability.

5.2 Support CD information

The support CD that came with the motherboard package contains the drivers,
software applications, and utilities that you can install to avail all motherboard
features.

/ The contents of the support CD are subject to change at any time without
notice. Visit the ASUS website(www.asus.com) for updates.

5.2.1 Running the support CD

Place the support CD to the optical drive. The CD automatically displays the
Drivers menu if Autorun is enabled in your computer.

[ L T T P e S e — =
Demarn | e | Gebedis | e | Geme

i Click an icon to
Drivers il U F— display support

. . CD/motherboard
R b o T information

Click an item to install

/ If Autorun is NOT enabled in your computer, browse the contents of the support
< CD to locate the file ASSETUP.EXE from the BIN folder. Double-click the
ASSETUP.EXE to run the CD.
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5.2.2 Drivers menu

The drivers menu shows the available device drivers if the system detects installed
devices. Install the necessary drivers to activate the devices.

ASUS InstAll-Installation Wizard for Drivers
Installs all of the drivers through the Installation Wizard.

NVIDIA nForce Chipset Driver
Installs the NVIDIA® Chipset drivers for the NVIDIA® nForce® 500 SLI chipset.

C-Media CM6501 Audio Driver
Installs the C-Media CM6501 audio driver and application.

AMD Cool ‘n’ Quiet Driver
Installs the AMD Cool ‘n’ Quiet! driver and application.

ASUS Al Remote
Installs the ASUS Al Remote driver and application.

USB 2.0 Driver
Installs the Universal Serial Bus 2.0 (USB 2.0) driver.

Chapter 5: Software support
Download from Www.Somanuals.com. All Manuals Search And Download.



5.2.3 Utilities menu

The Utilities menu shows the applications and other software that the motherboard
supports.

Utilities

—

ol
Phsme sedac bommn o s o
L. o e

ASUS InstAll-Installation Wizard for Utilities
Installs all of the utilities through the Installation Wizard.

ASUS PC Probe Il

This smart utility monitors the fan speed, CPU temperature, and system voltages,
and alerts you of any detected problems. This utility helps you keep your computer
in healthy operating condition.

ASUS Update
Allows you to download the latest version of the BIOS from the ASUS website.

% Before using the ASUS Update, make sure that you have an Internet connection
L. S0 you can connect to the ASUS website.

ASUS Al Gear
Installs the ASUS Al Gear.

ASUS Al Nap
Installs the ASUS Al Nap.

ASUS AMD Cool ‘n’ Quiet Utility
Installs the AMD® Cool ‘n’ Quiet! software.

ASUS Accelerated Propeller
Installs the ASUS Accelerated Propeller (ASAP).
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54

You can also install the following utilities from the ASUS Superb Software
Library CD.

N

Utilitie
m:_ﬁnb‘b'-h-bi

ADOBE Acrobat Reader V7.0

Installs the Adobe® Acrobat® Reader that allows you to open, view, and print
documents in Portable Document Format (PDF).

Microsoft DirectX 9.0c

Installs the Microsoft® DirectX 9.0 driver. The Microsoft DirectX® 9.0 is a multimedia
technology that enhances computer graphics and sound. DirectX® improves the
multimedia features of you computer so you can enjoy watching TV and movies,
capturing videos, or playing games in your computer. Visit the Microsoft website
(www.microsoft.com) for updates.

Symantec Norton Internet Security

The anti-virus application detects and protects your computer from viruses that
destroys data.

WinDVD Copy5 Trial
Installs the WinDVD Copy5 Trial version.

Corel Snapfire Plus SE
Installs the Corel Snapfire Plus SE software.
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5.2.4 Make Disk menu

The Make Disk menu contains items to create the NVIDIA® nForce™ 500-SLI SATA
RAID driver disk.

Make disk

Pl e e T BRI S EU g
b

NVIDIA 32/64bit 2000/XP/Vista SATA RAID Driver
Allows you to create an NVIDIA® Serial ATA RAID driver disk for a 32/64-bit 2000/
XP/Vista system.
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5.2.5 Manual menu

The Manual menu contains a list of supplementary user manuals. Click an item to
open the folder of the user manual.

% Most user manual files are in Portable Document Format (PDF). Install the
Adobe® Acrobat® Reader from the ASUS Superb Software Library CD before
opening a user manual file.

= T e e )

S | e s k| Wl |

5.2.6 ASUS Contact information

Click the Contact tab to display the ASUS contact information. You can also find
this information on the inside front cover of this user guide.

L e e e e e e I T F 1

o e Mt e et B |

Contact
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5.2.7 Other information

The icons on the top right corner of the screen give additional information on the
motherboard and the contents of the support CD. Click an icon to display the
specified information.

Motherboard Info
Displays the general specifications of the motherboard.

Drivers

P s et a1 P g

Browse this CD
Displays the support CD contents in graphical format.
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Technical support Form

Displays the ASUS Technical Support Request Form that you have to fill out when
requesting technical support.

Filelist
Displays the contents of the support CD and a brief description of each in text

format.
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5.3 Software information

Most of the applications in the support CD have wizards that will conveniently
guide you through the installation. View the online help or readme file that came
with the software application for more information.

5.3.1 ASUS MyLogo2™

The ASUS MyLogo2™ utility lets you customize the boot logo. The boot logo is the
image that appears on screen during the Power-On-Self-Tests (POST). The ASUS
MyLogo2™ is automatically installed when you install the ASUS Update utility from
the support CD. See section “5.2.3 Utilities menu” for details.

R +  Before using the ASUS MyLogo2™, use the Award BIOS Flash utility to
make a copy of your original BIOS file, or obtain the latest BIOS version
from the ASUS website. See section 4.1.4 Updating the BIOS.

+  Make sure that the BIOS item Full Screen Logo is set to [Enabled] if
you wish to use ASUS MyLogo2. See section 4.6.5 Boot Settings
Configuration.

You can create your own boot logo image in GIF, JPG, or BMP file formats.

To launch the ASUS MyLogo2™:

1. Launch the ASUS Update utility. Refer to section “4.1.1 ASUS Update utility”
for details.

2. Select Options from the drop down menu, then click Next.

Check the option Launch MyLogo to replace system boot logo before
flashing BIOS, then click Next.

Select Update BIOS from a file from the drop down menu, then click Next.
5. When prompted, locate the new

BIOS file, then click Next. The ASUS
MyLogo2 window appears.

6. From the left window pane, select the
folder that contains the image you
intend to use as your boot logo.

ASUS M2N-Plus SLI Vista Edition
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7. When the logo images appear on the
right window pane, select an image to
enlarge by clicking on it.

8.  Adjust the boot image to your desired
size by selecting a value on the Ratio
box.

9. When the screen returns to the ASUS Update utility, flash the original BIOS to
load the new boot logo.

10. After flashing the BIOS, restart the computer to display the new boot logo
during POST.
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5.3.2  Cool ‘n’ Quiet!™ Technology

The motherboard supports the AMD Cool ‘n’ Quiet!™ Technology that dynamically
and automatically change the CPU speed, voltage, and amount of power
depending on the task the CPU performs.

Enabling Cool ‘n’ Quiet!™ Technology
To enable Cool ‘n’ Quiet!™ Technology:

1. Turn on the system and enter BIOS by pressing the <Del> key during the
Power On Self-Tests (POST).

2.  Go to Advanced > CPU Configuration > AMD Cool ‘n’Quiet function and
set it to [Enabled]. See section “4.4 Advanced Menu.”

3. Save your changes and exit BIOS Setup.

4. Reboot your computer and set your Power Option Properties depending on
your operating system.

Windows® 2000/XP

1. From the Windows® 2000/XP operating system, click Start. Select Settings >
Control Panel.

2. Make sure the Control Panel is set to Classic View.

3.  Double-click the Display icon in the Control Panel then select the Screen
Saver tab.

Click the Power button. The following dialogue box appears.

5.  From the Power schemes combo list box, select Minimal Power
Management.

6.  Click OK to effect settings.

Fowe Uplicm oparian id ]
Prortd Libuiwmin | o] | 113
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% + Make sure to install the AMD Cool ‘n’ Quiet!™ driver and application before
& using this feature.

+ The AMD Cool ‘n’ Quiet!™ technology feature works only with the AMD
heatsink and fan assembly with monitor chip

If you purchased a separate heatsink and fan package, use the ASUS
Q-Fan technology feature to automatically adjust the CPU fan speed
according to your system loading.

Launching the Cool ‘n’ Quiet!™ software

The motherboard support CD includes the Cool ‘n’ Quiet!™ software that enables
you to view your system’s real-time CPU Frequency and voltage.

R Make sure to install the Cool ‘n’ Quiet!™ software from the motherboard support
CD. Refer to section 5.2.3 Utilities menu for details.

To launch the Cool ‘n’ Quiet!™ program:

1. If you are using Windows® 2000, click the Start button. Select Programs >
ASUS > Cool & Quiet > Cool & Quiet.

2. If you are using Windows® XP, click the Start button. Select All Programs >
ASUS > Cool & Quiet > Cool & Quiet.

3. The Cool ‘n’ Quiet!™ technology screen appears and displays the current
CPU Frequency and CPU Voltage.
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5.3.3

C-Media CM6501 audio utility

The C-Media Superior Quality Audio CODEC provides 8-channel audio capability
through the C-Media 6501 sound configuration software to deliver the ultimate
audio experience on your computer. The software provides high quality audio
synthesis/rendering, 3D sound positioning, and S/PDIF Out support.

Follow the installation wizard to install the C-Media CM6501 Audio Driver from the
support CD that came with the motherboard package.

If the C-Media audio utility is correctly installed, you will find the CM6501 Sound
Configuration icon on the taskbar.

From the taskbar, click on the C-Media icon to display the CM6501 Sound
Configuration Main Setting screen.

7

Main Setting

.ot
[ Jr_. -‘:i |

L

You must use 4-channel, 6-channel or 8-channel speakers for this setup.

C-Media requires Microsoft® Windows® 2000/XP/Vista version. Make sure
that one of these operating systems is installed before installing C-Media.

The Main Setting option allows you to configure your audio device settings and use
7.1 Virtual Speaker Shifter.

Click to select
channel

configurations.

Click E for
Advanced
settings.

Click = to
select S/PDIF
Output.

Click the drop-
down menu
for digital and

analog options.

! P luibirg E LR | idwneew

[[—r—

e Click [manil to
E set the digital
volume.
[l e Move the slider

—— of each speaker
to determine

Ly S, the volume.
Click (=2l
At Byain il f; o = W to reset the
T ﬂ T volume.
i F
_._ R Tmaan =
E: TS e,
[T | Click to effect
___ the settings and
[ exit.
Click to Click to stop
perform the the speaker
speaker test. test.

ASUS M2N-Plus SLI Vista Edition
Download from Www.Somanuals.com. All Manuals Search And Download.

5-13



7.1 Virtual Speaker Shifter

Click E to enable this function.

e I Y

Ot i Click to adjust the
L volume.
Lo Cam] L] o] Click to arrange the
Casll & position of the virtual
" il i, o speakers.
Dotddaoo Wins -
wannn, [N Click to reset the
speaker positions.
b flyate s bt

Click to effect the
settings and exit.

Mixer
The Mixer option allows you to configure audio output/input (record) volume.

Click the control tab and turn the volume button to adjust the output volume.

Make adjustments to Wave, SW Synth, Microphone, CD Player, Line Lin, and
Stereo Mix by clicking the control tabs and dragging the sliders up and down to get
the desired volume levels.

Click OK to effect the settings and exit.

| e o | irnaen

=]
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Effect

The Effect option allows you to set your listening environment, adjust the equalizer,
or select pre-programmed equalizer settings for your listening pleasure.

Click the shortcut buttons or the drop-down menus for options on changing the
acoustic environment. You may manually adjust the equalizer or select a pre-
defined mode according to music genre. To select an environment size, simply
click the shortcut buttons.

Click OK to effect the settings and exit.
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e nens Line [T |
N R oy o
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Information

Click the Information tab to diplay information about the 3D audio engine, audio
codec, audio driver version, audio controller, and DirectX version.
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5.34 ASUS PC Probe Il

PC Probe Il is a utility that monitors the computer’s vital components, and detects
and alerts you of any problem with these components. PC Probe Il senses fan
rotations, CPU temperature, and system voltages, among others. Because PC
Probe Il is software-based, you can start monitoring your computer the moment
you turn it on. With this utility, you are assured that your computer is always at a
healthy operating condition. Refer to page 1-6 for the OS that supports this utility.

Installing PC Probe Il
To install PC Probe Il on your computer:

1. Place the support CD to the optical drive. The Drivers installation tab appears
if your computer has an enabled Autorun feature.

% If Autorun is not enabled in your computer, browse the contents of the support
CD to locate the setup.exe file from the ASUS PC Probe Il folder. Double-click
the setup.exe file to start installation.

2. Click the Utilities tab, then click ASUS PC Probe II.
3.  Follow the screen instructions to complete installation.

Launching PC Probe II

You can launch the PC Probe Il right after installation or anytime from the
Windows® desktop.

To launch the PC Probe Il from the Windows® desktop, click Start > All Programs
> ASUS > PC Probe Il > PC Probe Il v1.xx.xx. The PC Probe Il main window
appears.

After launching the application, the PC Probe Il icon appears in the Windows®
taskbar. Click this icon to close or restore the application.

Using PC Probe i

Main window

The PC Probe Il main window
allows you to view the current
status of your system and change
the utility configuration. By
default, the main window displays
the Preference section. You can
close or restore the Preference
section by clicking on the triangle on the main window right handle.

Click to close the
Preference panel

Chapter 5: Software support
Download from Www.Somanuals.com. All Manuals Search And Download.



Button Function

Neonrzdd, | Opens the Configuration window
pTE LN Opens the Report window
“tﬂ Opens the Desktop Management Interface window
ECr Opens the Peripheral Component Interconnect window
g Opens the Windows Management Instrumentation window
USF'?F_{ Opens the hard disk drive, memory, CPU usage window
b Shows/Hides the Preference section
(= Minimizes the application
& Closes the application
Sensor alert

When a system sensor detects a problem, the main window right handle
turns red, as the illustrations below show.

When displayed, the monitor panel for that sensor also turns red. Refer to the
Monitor panels section for details.

Preferences
You can customize the application using the
Preference section in the main window. Click ool | Lnbeeieg Ermecrarmst | M
the box before each preference to activate or : )
deactivate il o
' M ey
W Byenth
WA CD Plape
| M crophone

ASUS M2N-Plus SLI Vista Edition
Download from Www.Somanuals.com. All Manuals Search And Download.

5-17



Hardware monitor panels

The hardware monitor panels display the current value of a system sensor such as
fan rotation, CPU temperature, and voltages.

The hardware monitor panels come in two display modes: hexagonal (large) and
rectangular (small). When you check the Enable Monitoring Panel option from the
Preference section, the monitor panels appear on your computer’s desktop.

& CPU

 crU &0 |
I 294 Rpmlj

Small display

Large display

Changing the monitor panels position

To change the position of the monitor panels in the desktop,
click the arrow down button of the Scheme options, then select
another position from the list box. Click OK when finished.

Moving the monitor panels
All monitor panels move together using a magnetic effect. If
you want to detach a monitor panel from ==
the group, click the horseshoe magnet ¥ CPU
icon. You can now move or reposition the

panel independently. |

Adjusting the sensor threshold value /4 CPU
You can adjust the sensor threshold J

value in the monitor panel by

clicking the or buttons. You can Click to
also adjust the threshold values inerease

) B value
using the Config window.
) Click t
You cannot adjust the sensor decrease

threshold values in a small value
monitoring panel.
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Monitoring sensor alert

The monitor panel turns red when a component value exceeds or is lower
than the threshold value. Refer to the illustrations below.

/3 cHassis

Large display

WMI browser

Click ™. to display the

WMI (Windows Management
Instrumentation) browser. This
browser displays various Windows®
management information. Click an
item from the left panel to display on
the right panel. Click the plus sign (+)
before WMI Information to display the
available information.

7

of the browser.

DMI browser

omr’

Click =555 to display the DMI
(Desktop Management Interface)
browser. This browser displays various
desktop and system information.

Click the plus sign (+) before DMI
Information to display the available
information.

ASUS M2N-Plus SLI Vista Edition
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Small display

WMI Browger

Windows Merogement
Insirumentation

Vs | A
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You can enlarge or reduce the browser size by dragging the bottom right corner

OMI Ercerser

Imterioce

Farsime 3 8204
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|
‘ Desktop Management
|
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PCI browser )
Click F= to display the PCI e

(Peripheral Component Interconnect) e
browser. This browser provides
information on the PCI devices installed
on your system. Click the plus sign

(+) before the PCI Information item to
display available information.

Usage
The Usage browser displays real-time information on the CPU, hard disk drive
space, and memory usage. Click Y% to display the Usage browser.

CPU usage
The CPU tab displays real-

time CPU usage in line graph
representation. If the CPU has
an enabled Hyper-Threading,
two separate line graphs display
the operation of the two logical
processors.

Hard disk drive space usage
The Hard Disk tab displays the
used and available hard disk
drive space. The left panel of the
tab lists all logical drives. Click

a hard disk drive to display the
information on the right panel.
The pie chart at the bottom of
the window represents the used —
(blue) and the available HDD —
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Memory usage
The Memory tab shows both used

and available physical memory.
The pie chart at the bottom of the
window represents the used (blue)
and the available physical memory.

Configuring PC Probe I

Click Ssmir, to view and adjust the sensor threshold values.

The Config window has two tabs: Sensor/Threshold and Preference. The Sensor/
Threshold tab enables you to activate the sensors or to adjust the sensor threshold
values. The Preference tab allows you to customize sensor alerts, or change the

temperature scale.

3 cantin &
TN P
KT Vil ncy | i S
Eriated SENTOT Name CUNTER W ke Theshoid
2] ] a3 —— Lo £
e I 3 —_— |4_s g
=
= ey O " e i A 1
Ak = BRI g |t AR, Tt A
Loads the default
threshold values for Cancels or Loads your saved
each sensor ignores your configuration
Applies your changes Saves your
changes configuration
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5.3.5

power consumption.

ASUS Al Gear

ASUS Al Gear provides four system performance options that allows you to select
the best performance setting for your computing needs. This easy-to-use utility
adjusts the processor frequency and vCore voltage to minimize system noise and

After installing Al Gear from the bundled support CD, you can launch Al Gear by
double-clicking the Al Gear icon on your Windows OS taskbar.

Shift the gear to the performance setting that you like.

Maximum
Performance

% Refer to page 1-6 for the OS that supports this utility.

5-22
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4

High
Performance

Medium
Performance
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5.3.6

ASUS Al Nap

This feature allows you to minimize the power consumption of your computer
whenever you are away. Enable this feature for minimum power consumption and
a more quiet system operation.

After installing Al Nap from the bundled support CD, you can launch the utility by
double-clicking the Al Nap icon on the Windows OS taskbar.

Click Yes

i’

on the confirmation screen.

R |

Are you sure that you want to enter Al Map
miode?

To exit Al Nap mode, press the system power or mouse button then click Yes on
the confirmation screen.

Al Nap

= |

Are you sure that pou want ta leave Al Map
mode?

7

To switch the power button functions from Al Nap to shutting down, just

right click the Al Nap icon on the

OS taskbar and click Use power button.

Unclick the item to switch the function back.

Refer to page 1-6 for the OS that supports this utility.
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5.3.7 Al Remote

With the ASUS Al Remote, you can play, pause, or adjust the volume on any songs
desired without leaving your sofa. Have Al Remote in your hand and do more with
your PC at a distance away.

Overview of the ASUS Al Remote

1. Power th =S
I— 3. Al Gear
2. Full Screen —— =7 m = 4. Al Nap
5. AP-1/2 Trigger T !
Ao B .- B .4 6. AP Menu
+———  Volume Up
——r— Play/Pause
7. Media Control Zone ...lq Bl e Ne)x
Previous
= ————— Volume Down

1. Power: Turns the computer on/off.

2. Full Screen: Puts the media application into full screen.

3. Al Gear: Changes modes for optimizing performance and quietness.
4. Al Nap: Snoozing system without terminating tasks into quietest state.
5. AP-1/2 Trigger: Initiates the pre-defined applications.

6. AP Menu: Displays the application menu.

7. Media Control Zone: Controls the media application.
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USB IR Receiver

Your motherboard will come bundled with a IR Receiver, simply connect the USB
end to your PC USB ports under the LAN2 port and place the IR receiver end at a
suitable place without hindrance.

IR Receiver

USB Ports

|— Infrared end

/ +  The valid IR function distance is 6m depending on the environment.
~ Suggest you to aim at the IR receiver when using the ASUS Al Remote to
ensure a smooth and successful operation.

+  These two USB ports support USB wake-up capability. So when the
computer is not turned on, removing USB devices such as the ASUS IR
receiver from these two ports will start up the PC.

+  Back I/O differs depending on the motherboards.

+  Refer to page 1-6 for the OS that supports the ASUS Al Remote.

Software Installation

Before enjoying the convenience the = T e
ASUS Al Remote brings you, you need —
to install the software after the infrared
receiver installation. Simply click and
install the file ASUS Al Remote from
Drivers menu of the Motherboard
Support CD package for the first

time, and it will launch automatically
everytime you start up your PC.

ASUS Al Remote
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Activating HID-Compliant Devices

Due to the limitation of the operating system, if you remove the IR receiver from
the previous port and have it reinstall into the other USB port, the IR receiver will
not function. To activate the HID-compliant devices again, go to Device Manager/
Power Manager and check the box of Allow this device to bring the computer
out of standby.

& 3% II.!-

1. Click Windows icon and 2. Double click System and
choose Control Panel. Maintenance.

Py

maEy &

3. Click Device Manager. 4.  Select HID-compliant device.

b =T

PE—

5. Check the box of Allow this
device to wake the computer.
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ASUS Al Remote Settings

After the installation of the ASUS Al Remote software, the utility screen will show
up and allows you to configure the ASUS Al Remote settings. Set up the function
keys following the instructions below.

1. Power On / Off Key

Enable power key
Click this box to enable this power button.

Enable power on after power loss

Click this box to restart the system after the AC power loss. Whenever the power
cord of your PC is removed from the outlet or there is a power failure, your PC will
auto-boot and shut down around few seconds to enable the Power On function of Al
Remote after the power supply is back.

Function switch

You can customize the Power key by switching the mode from Power off to
Hibernate or Standby based on your preference. Setting this item to Hibernate
allows you to lead your PC to the Windows S4 mode, which enables your PC to
enter Hibernate faster and return to full power much more quickly.

/ + Power On/Off button does not support MS-DOS Mode.

~ +  You have to check the box of Enable Power Key before using the ASUS Al
Remote to turn on and off your PC or to have it hibernate or standby. Visit
www.microsoft.com for details about Hibernate and Standby.
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2.AP-1/2

You are allowed to configure two sets of applications for AP-1 Trigger and
AP-2 Trigger buttons. After the setup, you can easily launch the pre-defined
application by pressing the designated button.

(1) Click the box before Use Profile, and you are able to select a default
application from the drop-down menu.

(2) To launch a non-default application, unclick the box before Use Profile.

(8) Click the Browse button and locate the executable (.exe) file of the
application you want to launch by pressing the AP-1 button.

(4) Follow the same instructions to configure the AP-2 button.

(5) Click Save to save the configuration.

3. Multimedia Keys
Profile

There are nine default applications in the Profile drop-down menu and five sets of
User Define.

% Default applications are Media Player, iTunes, PowerDVD, WinDVD, QuickTime,
- Real Player, DivX Player, WinAmp and Power Point. (Default applications in the
ASUS Al Remote software may change without notice.)

Path

The software will help locate the executable (.exe) file of the nine default
applications. If the .exe file is not located, click Browse to direct the correct path.
The .exe files of the User Define applications need to be located manually before
you using the ASUS Al Remote.

% +  Save after the .exe file path is directed.
+  If the executable file is relocated or the application is re-installed, you have

- to redirect the file path for a correct ASUS Al Remote operation.
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AP Menu Button and Application menu

Navigate with the media control zone.

upward

leftward rightward

enter
downward

Select Application Profile
After you press = (AP Menu) on the

remote control, an application profile
will be displayed on the screen. Use
the remote control to navigate and
initiate a desired application.

Select Application Profile

lect Application Path
If the software fails to locate the
executable file of the applicaton
at the first-time use, the Select
Application Path screen will appear.
Specify the correct path on screen.

lect Fill
After selecting the correct path, you
should select the correct executable
file (.exe) of the application for
launching the application.

LERE L L5 B

If the executable file is located by the
software successfully or you have
already set up correctly in advance,
this screen will show up directly
when the application is chosen.

After selecting a desired file, folder
or CD-ROM, use 1e«/ pp1 t0 choose
Back/OK/Cancel and then press

» 11 to confirm.
% + For music listening, making playlists beforehand is suggested.
L +  Press = again to close the application and again to re-launch the profile
menu.
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Define Hotkeys for Application

If you want to use the Media Control Zone to control non-default applications, such
as ACDSee, you can select User Define from the drop-down menu and rename
it by pressing Rename. The ASUS Al Remote software has correctly set up nine
popular applications and defined the funtion buttons for your convenient operation.

User Define

After clicking the box before Use
Hotkeys for Application, you are
free to define the hotkeys of the
User Define applications.

Select User Define 1~5 from

the Profile drop-down menu for
hotkeys definition. Press Save

to save the new setup or press
the Default button to clear ALL
personalized setups and restore to
the original definitions.

[ L e
T i P

L

| e
v L Pt

[rr—
|-

The remote control buttons will function only when the definitions of the
application hotkeys are correct.

The hotkey definitions may vary with different software versions. Click the
box of Redefine default hotkeys to give new correct definitions if needed.
Press Save button to save the redefinitions or press Reset button to restore
to the default hotkeys definition.

Atter the initial setup, you will find an ASUS Al Remote icon [g] on the
Windows OS taskbar. Click the icon and select Settings to launch the utility

screen.
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The Function Buttons and AP Profile

The ASUS Al Remote software helps you set up the correspondence between the
function buttons on the remote to the function hotkeys of nine popular applications

in advance and leaves five sets for User Define.

Media Player | iTunes PowerDVD QuickTime
Full Screen |v v v v v
>l \ v v/X % v
+ v v v v v
v v v v v
[ v v v v X
[Pw) v v v v X
*NOTE only play, no pause
Real Player |DivX Player |WinAmp Power Point | User Defne
Full Screen |v \ X v
>l v % v/x Full Screen
+ Y X v B
v X v ESC
[ \ X % Page Down
> v X v Page Up
*NOTE only play, no pause

7

If you find the 9 default applications insufficient and would like to add different
applications, you are able to rename the 5 sets User Define and create your
preferred applications and favorable setups.
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5.4
5.4.1

Windows® Vista feature
ASAP (ASUS Accelerated Propeller)

This motherboard is equipped with the ASUS Accelerated Propeller (ASAP)

feature. ASAP supports the Windows® ReadyBoost™ technology that improves
system performance under Windows® Vista. Refer to page 1-6 for the OS that
supports ASAP.

AN

To activate ASAP:

1. From the Windows® Vista desktop,
click Start > Computer.

2. Right-click on the USB Removable
Storage device (ASAP), and select
Properties.

3.  Click the ReadyBoost tab. A dialog
box appears.

4.  Check Use this device, and then
move the slider to determine the
amount of space researved for
ReadyBoost™ cache.

5. Click OK to effect the settings.

RSN

Before activating ASAP, install the ASAP utility from the bundled support CD.

[T — (=]

Gews | Tack | Hedsaw :u.
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i T reTTy 45 M o apama
T e e

When you see the existing partition for ASAP, we advise you not to delete

this partition that supports the ReadyBoost™ function. If you delete this
partition by accident, you may recreate it by:

Clicking Start from the Windows® Vista desktop. Right-click on Computer
and select Manage. Click Disk Management and right-click on the ASAP

drive. Select Format > OK. OR

Going to Start > Control Panel > System and Maintenance >
Administrative Tools > Computer Management > Disk Management.
Right-click on the ASAP drive, and select Format > OK.

+  If you accidentally remove the ASAP device from Windows® Vista, you may
re-activate it by rebooting your computer.

If you want to reinstall an operating system, uninstall the ASAP utility first.
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5.5 RAID configurations

The motherboard comes with the NVIDIA® SLI Southbridge RAID controllers that
allow you to configure IDE and Serial ATA hard disk drives as RAID sets. The
motherboard supports the following RAID configurations.

RAID 0 (Data striping) optimizes two identical hard disk drives to read and write
data in parallel, interleaved stacks. Two hard disks perform the same work as a
single drive but at a sustained data transfer rate, double that of a single disk alone,
thus improving data access and storage. Use of two new identical hard disk drives
is required for this setup.

RAID 1 (Data mirroring) copies and maintains an identical image of data from one
drive to a second drive. If one drive fails, the disk array management software
directs all applications to the surviving drive as it contains a complete copy of

the data in the other drive. This RAID configuration provides data protection and
increases fault tolerance to the entire system. Use two new drives or use an
existing drive and a new drive for this setup. The new drive must be of the same
size or larger than the existing drive.

RAID 0+1 is data striping and data mirroring combined without parity (redundancy
data) having to be calculated and written. With the RAID 0+1 configuration you get
all the benefits of both RAID 0 and RAID 1 configurations. Use four new hard disk
drives or use an existing drive and three new drives for this setup.

RAID 5 stripes both data and parity information across three or more hard

disk drives. Among the advantages of RAID 5 configuration include better

HDD performance, fault tolerance, and higher storage capacity. The RAID

5 configuration is best suited for transaction processing, relational database
applications, enterprise resource planning, and other business systems. Use a
minimum of three identical hard disk drives for this setup.

RAID 1+0 is a striped configuration with each stripe a RAID 1 array of drives. It
combines the features of both RAID 1 and RAID 0. Fault tolerance is provided
through mirroring while adding performance through striping. This offers higher
performance than a RAID 1 configuration but at a much higher cost. A minimum of
four hard disk drives is required for this setup.

JBOD (Spanning) stands for Just a Bunch of Disks and refers to hard disk drives
that are not yet configured as a RAID set. This configuration stores the same
data redundantly on multiple disks that appear as a single disk on the operating
system. Spanning does not deliver any advantage over using separate disks
independently and does not provide fault tolerance or other RAID performance
benefits.
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R If you want to boot the system from a hard disk drive included in a RAID set,
copy first the RAID driver from the support CD to a floppy disk before you install
an operating system to a selected hard disk drive. Refer to section 5.6 Creating
a RAID driver disk for details.

5.5.1 Installing hard disks

The motherboard supports Ultra DMA /133/100/66 and Serial ATA hard disk drives.
For optimal performance, install identical drives of the same model and capacity
when creating a disk array.

Installing Parallel ATA hard disks
To install IDE hard disks for a RAID configuration:

Set the jumpers of each hard disk as Master/Master or Slave/Slave.
Install the hard disks into the drive bays.

Connect the HDD signal cables.

Connect a 4-pin power cable to the power connector on each drive.

el

Installing Serial ATA (SATA) hard disks
To install the SATA hard disks for a RAID configuration:

1. Install the SATA hard disks into the drive bays.
2. Connect the SATA signal cables.
3. Connect a SATA power cable to the power connector on each drive.

A& Refer to the RAID controllers user manual in the motherboard support CD for
detailed information on RAID configurations. See section 5.2.5 Manual menu.
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5.5.2 NVIDIA® RAID configurations

The motherboard includes a high performance IDE RAID controller integrated in
the NVIDIA® SLI southbridge chipset. It supports RAID 0, RAID 1, RAID 0+1, and
JBOD with four independent Serial ATA channels.

Setting the BIOS RAID items

After installing the hard disk drives, make sure to set the necessary RAID items in
the BIOS before setting your RAID configuration.

To set the BIOS RAID items:

1. Boot the system and press <Del> during the Power-On Self-Test (POST) to
enter the BIOS Setup Utility.

2. From the Advanced > Onboard Devices Configuration > NVRAID

Configuration menu item in the BIOS set the RAID Enabled item to Enabled.

The succeeding items become user-configurable.

3.  Select and enable the IDE or SATA drive(s) that you want to configure as
RAID. See section “5.4.3 Onboard Devices Configuration” for details.

4. Save your changes and Exit Setup.

+ For detailed descriptions on the NVIDIA® RAID configuration, refer to the
“NVIDIA® RAID User’s Guide” found in your motherboard support CD.

When using Windows 2000 operating system, make sure to install the
Windows 2000 Service Pack 4 or later versions.

ASUS M2N-Plus SLI Vista Edition
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Entering the NVIDIA® RAID utility
To enter the NVIDIA® RAID utility:

1. Boot up your computer.

2. During POST, press <F10> to display the main menu of the utility.

R The RAID BIOS setup screens shown in this section are for reference only, and
may not exactly match the items on your screen.

NVIDIA RAID Utility Oct 5 2004
- Define a New Array -

RAID Mode: Striping Block:

Free Disks Array Disks
Disk Model Name Loc

[F6] Back [F7] Finish [TAB] Navigate

Disk Model Name

[1|] Select [ENTER] Popup

At the bottom of the screen are the navigation keys. These keys allow you to move

through and select menu options.

Creating a RAID Volume
To create a RAID volume:

1. From the NVIDIA® RAID utility Define a New Array menu, select RAID Mode
then press <Enter>. The following submenu appears.

Use the up or down arrow keys to select a
RAID mode then press <Enter>.

5-36

Striping
Stripe Mirroring

Spanning
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2. Press <TAB> select the Striping
Block then press <Enter>. The
following submenu appears:

If you selected Striping or Stripe Mirroring, use the up or down arrow keys to
select the stripe size for your RAID 0 array then press <Enter>.The available
values range from 8 KB to 128 KB. The default selection is 128 KB. The strip
value should be chosen based on the planned drive usage.

+8/16 KB - low disk usage
* 64 KB - typical disk usage
+ 128 KB - performance disk usage

R TIP: For server systems, we recommend using a lower array block size. For
multimedia computer systems used mainly for audio and video editing, we
recommend a higher array block size for optimum performance.

3." Press <TAB> to select the Free Disks area. Use the left or right arrow keys to
assign the array disks.

4.  Press <F7> to create RAID set. The following message box appears.

Clear disk data?

5. Press <Y>to clear the selected disks or <N> to proceed without clearing the
disks. The following screen appears.

) //é\ Take caution in using this option. All data on the RAID drives will be lost!
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NVIDIA RAID Utility Oct 5 2004
- Array List -

Boot Id Status Vendor Array Model Name

No 4 Healthy NVIDIA MIRROR  XXX.XXG

[Ctrl-X]Exit [{|]Select |[B]Set Boot [N]New Array [ENTER]Detail

Anew set of navigation keys is displayed on the bottom of the screen.
6. Press <Ctrl+X> to save settings and exit.

Rebuilding a RAID array

To rebuild a RAID array:

1. From the Array List menu, use the up or down arrow keys to select a RAID
array then press <Enter>. The RAID Array details appear.

Array 1 : NVIDIA MIRROR XXX.XXG
- Array Detail -

RAID Mode: Mirroring
Striping Width: 1 Striping Block: 64K

Adapt Channel M/S Index Disk Model Name Capacity

Master XXXXXXXXXXXXXXXXX XXX .XXGB
Master XXXXXXXXXXXXXXXXX XXX .XXGB

[R] Rebuild [D] Delete [C] Clear Disk [ENTER] Return
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A new set of navigation keys is displayed on the bottom of the screen.
2. Press <R> to rebuild a RAID array. The following screen appears.

Array 1 : NVIDIA MIRROR XXX.XXG
- Select Disk Inside Array -

RAID Mode: Mirroring
Striping Width: 1 Striping Block: 64K

Adapt Channel M/S Index Disk Model Name Capacity

Master 0 XXXXXXXXXXXXXXXXX XXX .XXGB
Master 1 XXXXXXXXXXXXXXXXX XXX.XXGB

[1]] Select [F6] Back [F7] Finish

3. Use the up or down arrow keys to select a RAID array to rebuild, then press
<F7>. The following confirmation message appears.

Rebuild array?

[ENTER] OK [ESC] Cancel

Press <Enter> to start rebuilding array or press <Esc> to cancel.
5. After the rebuild process, the Array list menu appears.

ASUS M2N-Plus SLI Vista Edition 5-39
Download from Www.Somanuals.com. All Manuals Search And Download.



Deleting a RAID array

To delete a RAID array:

1. From the Array List menu, use the up or down arrow keys to select a RAID
array then press <Enter>. The RAID Array details appear.

Array 1 : NVIDIA MIRROR XXX.XXG
- Array Detail -

RAID Mode: Mirroring
Striping Width: 1 Striping Block: 64K

Adapt Channel M/S Index Disk Model Name Capacity

Master KXXXXXXXXXXXXXXXXX
Master KXXXXXXXXXXXXXXXXX XXX .XXGB

[R] Rebuild [D] Delete [C] Clear Disk [ENTER] Return

A new set of navigation keys is displayed on the bottom of the screen.

2. Press <D> to delete a RAID array. The following confirmation message
appears.

Delete this array?

[¥] YES [N] No

3. Press <Y>to delete array or press <N> to cancel.

// g \ Take caution in using this option. All data on the RAID drives will be lost!

4.  If you selected Yes, the Define a New Array menu appears.
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Clearing a disk data

To clear disk data:

1. From the Array List menu, use the up or down arrow keys to select a RAID
array then press <Enter>. The RAID Array details appear.
Array 1 : NVIDIA MIRROR XXX.XXG
- Array Detail -
RAID Mode: Mirroring
Striping Width: 1 Striping Block: 64K
Adapt Channel M/S Index Disk Model Name Capacity
Master P.0.0.0.0.0.0.0.0.0.0.0.0.0.0.0.0.4
Master P.0.0.0.0.0.0.0.0.0.0.0.0.0.0.0.0.4 XXX .XXGB
[R] Rebuild [D] Delete [C] Clear Disk [ENTER] Return
A new set of navigation keys is displayed on the bottom of the screen.
2.

Press <C> to clear disk. The following confirmation message appears.

Clear disk data?

[¥] YES [N]

5. Press <Y> to clear the disk data or press <N> to cancel.

e

\ Take caution in using this option. All data on the RAID drives will be lost!
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5.6 Creating a RAID driver disk

Afloppy disk with the RAID driver is required when installing Windows® 2000/XP/
Vista operating system on a hard disk drive that is included in a RAID set.

To create a RAID driver disk:

. Place the motherboard support CD into the CD-ROM drive.
2. Select Make Disk tab.

From the Make Disk menu, select the RAID driver disk you want to create or
browse the contents of the support CD to locate the driver disk utility.

w

/ Refer to section 5.2.4 Make Disk menu for details.

4. Insert floppy disk to floppy disk drive.
5. Follow succeeding screen information to complete process.
6.  Write-protect the floppy disk to avoid computer virus infection.

To install the RAID driver:

1. During the OS installation, the system prompts you to press the F6 key to
install third-party SCSI or RAID driver.

2. Press <F6> then insert the floppy disk with RAID driver into the floppy disk
drive.

3. Follow the succeeding screen instructions to complete the installation.

% Due to chipset limitation, the Serial ATA ports supported by the NVIDIA chipset
& doesn’t support Serial Optical Disk Drives (Serial ODD) under DOS.
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6.1 Overview

The motherboard supports the NVIDIA® SLI™ (Scalable Link Interface)-Intel® Edition
technology that allows you to install two identical PCI Express” x16 graphics cards.
Follow the installation procedures in this section.

Requirements

. You should have two identical SLI-ready graphics cards that are NVIDIA®
certified.

+  Make sure that your graphics card driver supports the NVIDIA® SLI™
technology. Download the latest driver from the NVIDIA website (www.nvidia.
com).

. Make sure that your power supply unit (PSU) can provide at least the
minimum power required by your system. See “9. ATX power connectors” on
page 2-28 for details.

R + The NVIDIA SLI technology supports Windows® XP"™ 32-bit/64bit operating
system. Visit the NVIDIA website (www.nvidia.com) for the NVIDIA® SLI™
technology under Windows® Vista™

Visit the NVIDIA zone website (http://www.nzone.com) for the latest certified
graphics card and supported 3D application list.
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6.2 Dual graphics card setup
6.2.1 Installing SLI-ready graphics cards

R Install only identical SLI-ready graphics cards that are NVIDIA®-certified.
Different types of graphics cards will not work together properly.

To install the graphics cards:

1. Prepare two graphics cards. Each graphics card should have goldfingers for
the SLI connector.

Goldfingers

2. Remove the metal bracket covers opposite the two PCI Express x16 slots.

Chapter 6: NVIDIA® SLI™ technology support
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3. Insert one graphics card into either the blue or black slot. Make sure that the
card is properly seated on the slot.

4.  Insert the second graphics card into the other slot. Make sure that the card is
properly seated on the slot.

R If required, connect an aucxiliary power source to the PCI Express graphics
cards.
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5. Align and insert the SLI connector to the goldfingers on each graphics card.
Make sure that the connector is firmly in place.

6.  When installing two VGA cards using a 20-pin ATX PSU with sufficient+12v
capability, we recommend that you connect the auxillary power source from
the power supply to the graphics card. Refer to the PSU documentation for
dual VGA power requirements.

7. Connect a VGA cable or a DVI-I cable to the graphics card/s.

R We recommend to install an additional chassis fan for better thermall
environment.
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6.2.2 Installing the device drivers

Refer to the documentation that came with your graphics card package to install
the device drivers.

R Make sure that your PCI Express graphics card driver supports the NVIDIA SLI

technology. Download the latest driver from the NVIDIA website (www.nvidia.
com).

6.2.3 Enabling the multi-GPU feature in Windows”

After installing your graphics cards and the device drivers, enable the
Multi-Graphics Processing Unit (GPU) feature in the NVIDIA nView properties.

To enable the multi-GPU feature:

1. Click the NVIDIA Settings icon on
your Windows taskbar.
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From the Display Properties dialog
box, select the Settings tab then
click Advanced.

Select the NVIDIA GeForce tab.

Click the slider to display the
following screen, then select the SLI
multi-GPU item.
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Click the Enable SLI multi-GPU check box.

Click OK when done.
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